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POWERTEACHER
Logging in
URL: http://Yourseveraddress/teachers

{ PowerSchool

Teacher Sign In

Select Language English v

Username |

Password

Enter your username in the top box and password in the lower box then click on the
Enter button or your Enter key on your keyboard and a screen similar to the one below
will appear:

Welcome Help Sign Out
{ PowerSchool
School: School  Term: 15-16 Year
Navigation .

Current Classes

PowerTeacher Pro

ISIa\t Page
Daily Bulletin .. Homeroom Grade 4 =] s s =
Schedule HR1(Man-Fri) PowerTeacher Pro o i E g >\ &3 L
Staff Directory .
1(Thu) 3(Mon- English Language Arts Grade 4 ) = . . -
s § Tue Fri) 4(Wed) PowerTeacher Pro 42 lad E g >\ &v -
Personalize
Reports 1(Fri) 2(Mon-  English Language Arts Grade 4 } = . . =
Recommendations Wed) 4(Thu)  PowerTeacher Pro 4 E E' x & i—¢
2(Thu) 4(Mon- Social Studies Grade 4 ) = . . =
Tue. Fri) 5(Wed) PowerTeacher Pro 42 b E E’ >\ &v =
Launch - :
- I e e e e
District Code (BU,T[ dl.‘eJ PowerTeacher Pro i T A &3 =
LMRG e
Religion Grade 4 = -
2 Download on the B(Tue) eiglon Brade 4 = E g >& &v =

. App Store 7{Mon,Fri) PowerTeacher Pro

Notice only the classes you teach are listed.
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Left Navigation Icons

Navigation 4 PowerTeacher Pro

PowerTeacher Pro

IStart Page Gradebook.

Daily Bulletin
Schedule

Staff Directory L
Meals M Qﬁws‘m

» HR1(Mon-Fri) Homeroom Grade 4 - 15-16

Select Classes

PowerSchool

Personalize Welcome to PowerTeacher Pro!

Repor‘ts H@ PowerTeacher Pro combines an intuitive user interface with robust functionality for
managing the classroom. In addition to providing advanced features for both standards-
. based and traitional gracing, PowerTeacher Pro improves tremendously on the previous
Recommendations gradebook. It also provides the same great user experience and full functionality from any
computer or tablet, indluding Mac. Windows. i0S. Android, and Chromebooks

New features include:

+ Easyto-use class progress graphs and charts

+ Enhanced single student views. giving a 360-degree view of performance
+ Quick access to assignment scoring

+ New Incomplete and Absent score attributes

+ And many more of the most highly requested enhancements

Old Gradebook

| Launch ] - |

District Code

Jownload on the

Start Page

| ¢ App Store

The PowerTeacher Pro link will take you to the PowerTeacher Pro

Qcreate o 1

Create
Assignments

The Start Page link will take you back to the first page after you

log in.

[ ) PowerSchool

School:

Welcome,

Help | Sign Out

School  Term: 15-16 Year

Navigation

R Current Classes

[ stan Page
Dally Bulletin Hometoom Grads 4 =
HRIMon £
Schedule RIMn T poerTsacher Pro b = ] L
L= ) 3Mon- English Language Arts Grads 4 -
. Thu) 3don- - English Language Ans Grade o s B R
Tue Fr) 4{Wed) PowerTeacher Pro
Personalize §
Reports A(Fr) 2an- English Language Arts Grade 4 " -
Recommandations Wed) 4(Thu)  PowerTeacher Pro " =] L
2(Th) &iMon.  Social Studies Grade & §
Tue i) 5(Wed) PowerTeacher Pro ° = B B
AFA) 3T gocial Suudies Grade 4 .
5iMon-Tus) a 8 B
et PowerTsacher Pro L
6(Tue)  Religion Grade 4 - i
TiMon Fri)  PowerTeacher Pra “ ” =] =

Daily Bulletin

X X X XXX

FEPRRERER

@ m

m

a

The Daily Bulletin link allows your administrators to communicate with teachers and

parents.

View Daily Bulletin

View other dates:
Scheol Bulletin for Friday, April 15, 2016

No bulletin items were found for this date.

Comments? Something to put in the bulletin? Email to ryan@stwilliamtheabbot net

View other dates: 04/15/2016

PREPARED BY: 8
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Schedule

The Schedule link displays the Teacher’s schedule Matrix.

~ Filter
Co-Teacher Sections:  Only Display Current Sections:
[ Show @] =0
Schedule
Sections for curent school only.
Day Terms HR1 0 1 2 3 4 5 L
_ English Language ) )
T1  Homeroom English Language e o Social Studies
Grade 4 Arts Grade 4 T Grade 4
= T 9000441 5014.41 e 4014.41
Mon = T2 Room 24 Room: 24 . (T::)";(Mon Room 24
___ HRI(Mon- 1(Fri) 2(Mon- e 2(Fi) 3(Thu) 5(Mon-
Fri) 15-16 \Wed) 4(Thu) 15-16. e Tue) 6(Wed) 15-16
]
335 3135 e 3135
T1 Homeroom English Language E"“A':hgﬁ:';!l":“ Social Studies
_ Grded | AisGrade4 T Grade 4 |
. 90004.41 5014.41 e 4014.41
Tue 1o T2 Room 24 Room: 24 . (T:l‘.’)";wm Room 24
__ HRIMon- 1(Fri) 2(Mon- Tl T B 2(Fri) 3(Thu) 5(Mon-
Fri) 15-16 Wed) 4(Thu) 15-16. S Tue) 6(Wed) 15-16
L 313 31135 3135

30/35

Staff Directory

The Staff Directory link allows you to view information about your colleagues.
Information must exist in PowerSchool before any information can be viewed here.

Staff Directory
Listing options: All - Teachers - Staff - Lunch Staff - Substitutes
# Name Room Email Home # School #
1 Geraldine 52 e tnet 516- 516-
2 Vincente Music @ t.net 516- 516-
3 . Christine Ass't. Principal e t.net 631- 516-

Meals

The Meals link allows you to view your personal lunch balance if your school uses

PowerLunch.
Meals
Current Meal Balance: 0.00
Date Time Net Description
Personalize

The Personalize link allows you to change your password and set up the page most
useful to you after you log on.

Diaily Bulletin
Staff Directory Function Description
Meals Personalize Optidn
Personalize wi Change Password Change current password to & new one.
Gradebook Default Student Screen Sets the initial student screen.
Reports . . . .
H _ Display Section Mumber Show or hide the Section Number on the Teachers home page
Recommendations

PREPARED BY: 9
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Reports
The Reports link allow you to print reports that have been made available to you by your

school’s PowerSchool administrator
Reports for All Students

Which report would you like to print? Class Attendance Audit

For which students? All 61 students in my classes.
Test print? Print only the first |2 pages

Watermark Text

Watermark Mode Overlay v
When to print ASAP

Report Output Locale English =

Recommendations

The Recommendations link will allow schools that use Teacher Recommendations to
submit/view recommendations for a group of students or a single student.

(I EEEEEEE————
Basic Filter u
Year = Last Name First Name Course Number Course Name Created Comments Edit

Old Gradebook
The link for the Old Gradebook is used if a teacher still has one or Hﬂ
more sections associated to Powerteacher Gradebook. Click on the | Oder Launch |
Arrow to select the Installer Method or the Old Java based launch
method.

District Code

If teachers are still using PowerTeacher Gradebook, then the 4-character code that
teachers would need to log into the PowerTeacher Mobile App for Ipad will appear. This
app is only used by teacher that are still using PowerTeacher Gradebook. There is not a
Mobile App for PowerTeacher Pro as this gradebook is available in full form on all

platforms/devices.

PREPARED BY: 10
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Additional Start Page Icons:

Help | Sign Out
Help
The Button at the top right part of your screen next to the Logout Button can answer

many questions. Please be sure you are located on the page you wish to receive
information about. Then click on the ? symbol for more information.

PowerSchool Icon
The PowerSchool icon in the upper left corner is the POW@FSChOOl

Home key for PowerTeacher. Click on the Icon to return
to the Start Page in PowerTeacher.

Course Icons

Seating Chart Setup

PowerSchool now has the ability for Teachers to create seating charts. Seating Charts
can then be used to take attendance. As a result, the Seating Chart Design option is
located within the Attendance pages.

Within the Seating Chart, the teacher has the ability to create arrangements using rows
or tables, the number of which is set by the teacher.

To Create a Seating Chart the teacher would first click on the Attendance Chair from the
Start Page and then go to Seating Chart Design.

[ Seating Chart: Homeroom - 1(A)

Single Day | Multi-Day | Seating Chart | Seating Chart Design New Layout [~]

T e T o I = = L [

Add Students 1

il :

Trevor Zuniga

iy

Joshua Klinger

L[31

i+

PREPARED BY: 11
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e To add a row, click on the Row Button.
Select the desired number of rows and
Columns and then click Add.

: Seating Chart: Homeroom - 1(A)

| single Day | Mutti-Day | Seating Chart | Seating Chart Design New Layout [~
=TT e e e

Add Students 1/

~t

Trevor Zuniga

Vv

Joshua K]inger

iy

Chris Booth

Vv

Jessica Bron

e [0 add Tables, click on Table button.
Select the desired number of tables, the
number of chairs at each table and then
number of tables to appear in each row.

Single Day | Mutti-Day | Seating Chart | Seating Chart Design New Layout |v| EE

sons Y ER o EEOE covos =3
s

Add Students

chisBoon ‘

i
Fil

Add Rows of Chairs ®
Rows 4 23
Chairs per Row 4[]
Total # of New Chairs =16

[t

: This would return a blank chart that looks like
ru7 the picture on the left

Add Chairs in a Table Format x
Tables E.IE‘ Tables Across 2 E‘
Chairs per Table 4 [=]
Qrientation Horizontal Vertical
Total # of New Chairs =16

(it

: This would return a blank chart that looks like
""" ‘ the one to the left.

e To add a single Chair, click on Chair button. This will add one additional chair to

your chart.

e You can also add additional items to your chart such as a Teacher’s desk, White
Board, Door and Class label. To add any of these items you would simply click on
the appropriate button at the top of the screen. These items allow you to orient

your room correctly.

e To remove an item from the Chart simply highlight (click on) that item and then

click Remove.

PREPARED BY: 12
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You can "UNDO” your last movement by clicking the Undo button.

[ ]

e The Scale slide on the right side of the screen will allow you to zoom in/out of your
seating Chart.

e You can also move any item on the chart by clicking on and dragging the item

where you want it to sit.
PO |- Taie | = char | o.,,-ea;nﬂm conrols (210 X CE "

| Add Students ¢

Populate »

i B

Trevor Zuniga

LT |

Joshua Klinger l

L[77/

Chris Booth

L7

Jessica Brown ‘

el

Clear All ¢

e Once you have finished the layout of your seating chart you can save the layout by
clicking Edit. When you do this a new window will appear. Give this layout and

Name and Description and then click “"Save as New”.
Basic Table [r| [EHSid<—

seating Chart | Seating Chart Design ]

e R FIrE ..
Edit Layout

Layout Name Basic Table
Description

2000 characters left

 Detete | save s New Jf cancel Jf ok |

Default Layout

e After your layout has been saved, you can populate it with students by clicking on
the Populate button. This new window will ask how you want your students

arranged on the page,
Add Students to Seats ®
Sort By @ Alphabetically
) Alternate MIF
! Random
Order A-Z[~]
Display Last Name E|
Start Top Left
Cancel m
Boftom Left

Bottom Right

- [T Losic

PREPARED BY:
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e Choose how you want your students Sorted, whether you want them ordered A-Z
or Z-A, whether you want the First Name or Last Name Displayed, and finally
when populating the chart do you want PowerSchool to start adding student from
the Top Left or Right or the Bottom Left or Right. Once you have made all
your selections click Add.

e Finally, after you have finished creating and populating your seating chart be sure
to hit "Save” to capture any changes.

Attendance

Teachers have multiple options for how they would like to take attendance. They can
take attendance for just a Single Day, for Multiple Days or using the Seating Chart.

Once any of the attendance options is selected, the teacher gains access to the
additional options of entering attendance for a Single Day (date of their choosing or
current date depending on School Setup), for Multiple Dates (if enabled) or through the
Seating Chart. Additionally, in the Single Day view, Teachers can see any Alerts that
have been created students. To view the Alert information simply click on the Icon to
open the Alert window. -

Record Meeting Attendance: Homeroom - 1(A)

Single Day | MultiDay | Seating Chart | Seating Chart Design

Attendance Code = Date Classes
EETNE] e e

Students Alerts Attendance: Tuesday, July 10, 2012
Booth, Chris M

Brown, Jessica C X
Coffey, Raul L

Gahner, Matt G TLi
Gall, Brady G

Goodrich, Joshua C k. 5

Henderson, Aaron B

[—

e From the Start Page, click on the Chair Icon. =

e First, select the attendance code from the drop down.

e Next click the Date for which you wish to enter attendance.

e If there are multiple sections of this course you can click on Show Multiple
Sections. It will then show you a combine roster of students. Click Show Single
Sections to revert to just the one section.

e Click into the blank field to the can either select the correct Attendance code from
the drop-down menu at the top then click in the box to the right of the student’s
name. Whichever attendance code you initially selected will appear at the top of a
new drop down. Simply move to the next student or if you need to select a
different code do so from this drop down.

PREPARED BY: 14
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Once an attendance code has been
entered for a student you will see a
gray balloon icon appear to the right
of the code. By clicking on this icon
a teacher can now enter Attendance
Comments.

Attendance: |

A

v

%

Students Alerts. Attendance: Tuesda)

Booth, Chris M A
Brown, Jessica C b 5 A
Coffey, Raul L 4 T
Gahner, Matt G ¥Li (Present) ||
Present
Gall, Brady G A (Absent)
. T (Tard
Goodrich .lashua C E 8
Edit Gomments x
Enfer Affendance Comments here.
Approximately 1969 characters left

e Once all information for this class has been entered click submit to save the
attendance information. Note that students are assumed present so you do NOT

actually need to select the present code.

e After you have clicked SUBMIT a green dot will appear that confirms attendance

has been recorded for this class.

Multi Day Attendance -

% \ L 4 Att Grid
=
#

Att Grid

Att Grid

e First, select the attendance code from the drop down.

e Next Select the Date Range for which you wish to enter attendance. Note that
PowerSchool will default to the current Month’s Attendance

e If there are multiple sections of this course you can click on Show Multiple
Sections. It will then show you a combine roster of students. Click Show Single

Sections to revert to just the one section.

e Click into the cell for the blank field for the student/date you wish to enter
attendance for. Whichever attendance code you initially selected will appear at
the top of a new drop down. Simply move to the next student/date to enter the
next code. Note that you do not actually have to select the attendance code first,
you can click into the date cell and select the code directly from the list of

available codes.

r
Record Meeting Attendance: Homeroom - 1(A)

Single Day | Multi-Day | Seating Chart | Seating Chart Design

Attendance Code  Date Range

(Present) [~]

Classes Comments

Total 72-7i8

Students (19) AT M T W H F M T
Baooth, Chris

Brown, Jessica o=

Coffey, Raul e )
Gahner, Matt = =

Gall, Brady 2 -

Goodrich, Joshua =

I I I O B O

Henrie, Kaeli - (Present]
enrie, Kaeli A {Absent)
Hubenette, Paul 1-] @ T (Tard:

Klinger, Joshua

PREPARED BY:
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e Once an attendance code has been entered for a student you will see a gray
balloon icon appear to the right of the code. By clicking on this icon, a teacher can
now enter Attendance Comments.

Edit Comments x

Enter Atiendance Comments here.

Attendance:

A

v

w

Approximately 1969 characters left

 cancel ok

e Once all information for this class has been entered click submit to save the
attendance information. Note that students are assumed present so you do NOT
actually need to select the present code.

e After you have clicked SUBMIT a green dot will appear that confirms attendance
has been recorded for this class.

=\

-,
=

Att Grid

f=d Att Grid

f=d Att Grid

Please note that Attendance taken through the Seating Chart may be taken for a Single
Date and Single Section.

e First, select the attendance code from the drop down.

e Next click the Date for which you wish to enter attendance.

e Click into the Drop-Down box for the student for whom you wish to register
attendance. Select the Attendance code. Move to the next student and repeat.

e Once all attendance has been entered click submit.

PREPARED BY: 16
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Knife and Fork

| single Day | Mutti-Day | Seating Chart | Seating Chart Design |

Random Student Selector

Basic Table []

Attendance Code Date

(Present) |E|

Wed 7/11 (Today) [~ ]

[~

| -
Brady Gall

Homeroom 1[{A)

a'+bc’ “l\

e
Jennifer Peters

[ el

Vi

L -
Chris Booth

(] =]
oy | v
Charise Watts | | Joshua Klinger

/ -

(=] (]

s
Bryan Koller

o~
Kaeli Henrig

(=] (]

L[¢74

s
Trevor Zuniga

Vo

L

Erin Moen

Used for submitting lunch counts, if PowerLunch is being used.

Submit Lunch Counts

Printer

Student Breakfast
Student Lunch

Student A La Carte

Milk

Adult Breakfast
Adult Lunch
Adult ALa Carte
Other 1

Other 2

Used to print any reports that have been made available to you.

Print Class Reports

Which report would you like to print?

For which students?
Test print?

Watermark Text

Watermark Mode
When to print

Report Qutput Locale

PREPARED BY:
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The 6 students in this class.
Print only the first | 2

English »

pages.
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Backpack Icon

The Backpack Icon allows the Teacher to view information specific to each student.
Many of these pages are the same as Student screens available on the Admin side of

PowerSchool.

Once you click on the Backpack Icon (g, it will take you to the Student Information
screen.

Click on the name of the student to open the Screen Selection Page.

I Welcome, Lisa Cahall | Help | Sign Out

Homeroom Grade 6 PovverTeacher

HRA (h-F)

Click on last hame to take vou to School: Rockville Example School ~ Term: 11-12 Year
Asarf® e

other
Atkinson, Annie

Dempsey, Jane

e Student Information
Jones, Mary
IUse the havigation pane on the |eft to work with the students listed.
2Cimnge t?l. *__(___. Cllick on
SEA: . snoc asi 0 @Ak o the student's last name to 5o to your default student screen.
- you to
4(A) 6

e another « Click on the student's first name to go to the last student screen viewed.
class. i.e. - Ifyou last looked at an Attendance page, clicking the student's first name will take you to the Attendance page for
that student

Standards Surnmary

« Click on a class name to change the current list of students to those in that class

Click on the LAST NAME of a student for menu items as a drop down to appear on the
right. After choosing a menu item, click on the subsequent FIRST NAMES to stay on

the current screen!

Click on a Class Name to take you to another class!

Backpack Menu Items - (Drop-Down Selections)

Select screens r
Select screens
Cumulative Grade Information
Demographics
E Graduation Plan Progress
Meeting Attendance
Net Access Summary
Print A Report
Quick Lookup
Recommendations
Schedule
Student Photo
Submit Log Entry
Teacher Comments
Term Grades

U ZUTF UTTUTTZUTO
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1. Cumulative Grade Information - This is the same as the Cumulative Info
Screen on the Admin side and Shows

2. Demographics - Shows basic demographics information as entered via the
Admin Portal.

3. Final Grade Entry - This is only available if turned on and is used for Final
Standards Grade entry through PowerTeacher. (Standards Grades entered
through the PowerTeacher Pro will not appear here. Likewise, Standards grades
entered her will not appear in PowerTeacher Pro.)

4. Graduation Plan Progress - This is the same screen as the Admin side. It will

only appear if a Graduation Plan has been setup for the school.

Meeting Attendance - Shows Period attendance for the student

Net Access Summary - (Date and duration of when a parent has accessed their

child’s information)

7. Print a Report - If reports have been opened to Teachers then they will appear
here. This option only prints reports for the selected student.

8. Quick Lookup - Same Screen as the Admin side. This is an overview for each
student and shows the students class schedule and attendance. Clicking on Term
Grades will open the Score display screen so you can see assignments/scores
earned in each class.

9. Recommendation - Teachers use this screen to make course recommendations
for future schedule requests (High Schools).

10. Schedule - This screen shows the selected student’s current class schedule.

11. Student Photo - This screen will display the selected student’s photo if one
has been uploaded to PowerSchool.

12. Submit Log Entry - Allows teachers to submit Log Entries (Discipline, Medical,
etc.) if Log Entries have been configured for the school. Note teacher cannot see
Log Entries once submitted.

13. Teacher Comments - This screen allows teachers to see any comments Final
Grade Comments that have been entered for a student. Comments for different
terms can be viewed by selecting the appropriate Term from the top of the
screen.

14. Term Grades - This screen allows the teacher to see Final Course grades for the
current year.

o w
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POWERTEACHER PRO

Welcome to the new PowerTeacher Pro Gradebook for PowerSchool Version 10.1+. With
PowerTeacher Pro, no longer will users have to worry about “launching” the gradebook
as PTP is now built into the web pages of PowerTeacher. Being built on the HTML5
platform, PTP is now fully functional on both Window and Mac, Android and iPhone, Ipad,
Windows and Android tablets as well as on Chromebooks. Teachers will no longer need
a separate mobile app to access the gradebooks as the new version is fully functional on
all mobile devices.

Accessing PTP

After logging into PowerTeacher click on one of the links for PowerTeacher Pro.

Navigation ; Click on Main PowerTeacher Pro link to open first class in the list of classes.
Arrent Classes

PowerTeacher Pro

| start Page
Daily Bulletin Homeroom = =
¥ ] - =
Schedule 1A PowerTeacher Pr 22 = @ Ff & =
Staff Directory .
° 2nd Grade English = -
Supmit Lunen Gounts e PowerTeachefPr:\ » = & &= [&ﬁ =
Meals '\
Personalize ] 2nd Grade Math Click on - =] -
3(A] 25 =i
Reports ) PowerTeacher Pro s PowerTeacher Pro = @ g (&9 .-
Recommendations , 3rd Grade Social suﬂe_s'-_ link for a specific a = @ E- — =
A PowerTeacher Pro class to open PTP il = & =
[Gouncn ] - ] Ja 2nd Grade Social sw/ in selected class. ) . i F . =
1 ) PowerTeacher Pro ° = 1 (% -
District Code
_ - 2nd Grade Science 25 = @ E- - =
A PowerTeacher Pro > ﬁ‘ T &9 .-

This will bring you to the PowerTeacher Pro Assignments screen for the selected class.

(Clicking on the PowerTeacher Pro link under Navigation will open PTP to the
Assignments screen for the first class in your class list in PTP. Clicking on the PTP link
for a specific class will bring you to the Assignments screen for the selected class.)

H;T‘ PowerSchool » HR1(Mon-Fri) Homeroom Grade 4 - 15-16

A8 Assignments ™ v

[E No assignments currently exist for this class and selected reporting term
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Gradebook Elements

Y PowerSchool » 25 2nd Grade English - 16-17 (1]
A+ Q3 has not started e 4

Grading

Assignments @® Qv -
i 5

Students No assignments currently exist for this class and selected reporting term.

Top Bar

1. Class List - This is the list of classes. Click on the lists to select the class or
group of classes in which you want to work.

2. Create - Use this link to Create New Assignments and or Categories.

3. Help - Click on the link to access the PowerTeacher Pro Help window. Options
available include, Online Help, Tips and Tricks, Getting Started Outline, What's
New and Video tutorials.

4. Sign Out - Click on the Teacher Name to access the link to Sign Out of
PowerTeacher Pro as well as select the Display option for the gradebook.

5. Options Gear- Click to access the ability to hide/show various elements at the
top of the screen as well as access the Copy Assignment Function. Options
included will depend on the screen you have selected.

6. Term - Click to select term in which you wish to work. The current term will
display based on the current date and the Default Term setup value set from the
Admin side of PS.

Charms Bar

7. Grading - Click this link to access: Assignment List, Scoresheet, Categories
Setup, Traditional and Standards Final Grades as well as Comment Verification.

8. Students - Use to access information for individual students. Available
information includes: Assignments, Comments,

Demographics and Quick Lookup.

9. Progress - Use this link to View Graphically, how students are doing across
terms.

10. Reports — Use this screen to access built in reports. Currently, available reports
include: Individual Student Report, Multi-Function Assignment Report,
Scoresheet and Student Roster.

11. Settings - Use this link to access display option for the gradebook. Available
options currently include: Display Settings, Class Description, Traditional Grade
Calculation, and Recalculate Final Grades.

12. Apps - Use this link to return to the PowerTeacher Portal.

13. Assignment List - Displays a list of all assignments for the selected class(is).
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1. Switching Classes

In PTP you have the option of working with an individual class or working with a pre-
determined group of classes. Groups are defined one of four ways. Course number,
Period/Day, School and All Classes.

Class Groups allow the teacher to create categories and/or assignments that apply to all
classes within the selected group. (Currently, teachers cannot create their own groups.)

To select a class and/or group:

1. Click on the drop-down list at the top of the Start Page.
2. If the teacher wishes to work with a single class click, on the Classes tab. If the
teacher wishes to work with a group of classes, click on the Group Tab.
3. Select the Class or Group in which you wish to work.
a. Clicking on the Name of the Class will take the teacher to the Assignment
List for the selected class.
b. Clicking on the blue Grid Icon, to the right of the class name, will take the
teacher to the Score Sheet View for the selected class.
c. Clicking on the Graph Icon, to the right of the class name, will take the user
to the Standards Progress screen for the selected class.

1 ¥ HR1(Mon-Fri) Homeroom Grade 4 - 15-16

» 15-16 (2015-2016) ol
E e Classes ~ Groups Settings E I:

HR1(Mon-Fri) Homeroom Grade 4 15-16 E ol
1(Thu) 3(Mon-Tue,Fri) 4(Wed) English Language Arts Grade 4 15-16 E ol

e 1(Fri) 2(Mon-Wed) 4(Thu) English Language Arts Grade 4 15-16 ﬂ ol
2(Thu) 4(Mon-Tue Fri) 5(Wed) Social Studies Grade 4 15-16 E o
2(Fri) 3(Thu) 5(Mon-Tue) 6(Wed) Social Studies Grade 4 1516 | @ | gl
6(Tue) 7(Mon.Fri) Religion Grade 4 15-16 E o
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Groups:

Groups are created automatically in PowerSchool. Currently, classes will be grouped
using the following criteria:

1. Course number - Classes that have the same course number will
automatically be grouped together.

2. Period/Day combination - Classes that meet the same period and day will be
grouped together.

3. School - If a teacher teaches in multiple schools, and the accounts are linked
through a Unified Teacher Record, then the teacher will ALL classes from ALL
schools within the available classes. Additionally, the teacher will see a
separate class group for each of his/her schools.

4. All Classes - This is a group of ALL classes within the teacher’s gradebook.
Class Groups allow the teacher to create categories and/or assignments that
apply to all classes within the selected group. (Currently, teachers cannot
create their own groups.)

To see which classes are included within a specific group, click on the down arrow to the
left of the group name. Click on the group itself to work with that group of classes.

p 1516 (2015-2016) jeo)
Classes Groups Setlings

2 AllClasses TR

COL'YW}W’
v nglish Language Arts Grade 4 - 2 Classes mn ol

1(Thu) 3({Mon-Tue,Fri) 4(Wed) English Language Arts Grade 4~ 15-16 & gl
1(Fri) 2(Mon-Wed) 4(Thu) English Language Arts Grade 4 516 g o

> Social Studies Grade 4 - 2 Classes
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2. Create

Creating Categories

PowerTeacher Pro allows for Administrators to push out some District/School level
settings to Teacher’s Gradebooks. One of those items is Categories. Teachers can then
create additional categories directly in PTP. With PowerTeacher Pro you can create
categories that are available to all sections or you can create categories that are

available only to selected classes.
Create a new category:

1. Click on Create.

Assignment
L
ategory

2. Select Category from the drop-down list. — -

On the next screen:
3. Click on the Category tab.

4. Select the Class(es) for which
you wish to associate this category.

5. Give the category a Name.

6. Select a Color for the category.

7. Check to Make the Category Active.

8. Give the category a Description.

PREPARED BY:

Caiegory Assignment Defaults View All

{ E Classes where you are the lead teacher are available for this category

o Select Classes v

2 Classes: English Language Arts Grade 4 [ 1(Fri) 2(Mon-Wed) 4(Thu), 1(Thu) 3(Mon-Tue,Fri) 4(Wed)
1

Name* e Class Project
Color 6
Status o Active @

6 Projects that involve group participation|

Limit this category to these classes

. Blue v

Inactive

Description

Cance' E
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Set the Assignment Defaults for the category (click on the tab). Assignment Defaults
allow the teacher to set the most common attributes for assignments within a given
category. (Assignment defaults, can be overwritten, at the assignment level.)

9. Assign a Score Type A Category - Assignment Defauts | View Al
Score Type e Points
a. Point (point value other than 100)
b. Percent (assignment based on 100) Mg memewesuarons | Remowever - Score Eny Points 100
c. Grade Scale (use the “Letter” grade @ xWeignt w
from the associated Grade Scale) N .
d. Collected Only (does not count

towards final grade only used to s Points ® 100 100
mark assignment as collected)

Publish Assignment @® reoaey
10. Assign Weight (if any)
11. Assign Extra Points (if any)
12. Select the Publish Assignment Options ‘
Publish Scores @ v |
a. Immediately - The Assignment Count n Final Grade o 4
appears as soon as the assignment
is saved. oo |
b. On a Specific Date - Enter the
date you want the Assignment to appear.
c. Days Before Date Due - Enter the number of days Before the due date
that You want the assignment to appear.
d. On Due Date - Assignment will appear on the Due date as entered on the
assignment.
e. Never - The assignment will not appear on any of the Public Portals. Please

be aware that the assignment score will still average into the Final Grade
course grade even though the assignment is not visible.

13. Check the box to Publish Scores.

Click Save to save the category.

PREPARED BY:
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View All Categories

1. Click on the View Tab to see a list of all categories

This is a view only display which shows the color, Name, Classes Using the
category and the Status (If active, a check will appear).
have the school Icon to the right have been pushed out by the

School/District. Editing Categories will be discussed in a later section.

Categories that

A\ Category Assignment Defaults Wiew All
COLOR NAME CLASSES USING STATUS
. Classwork __ é  AllClasses (15-16) v
=]
own —
. Project S -g /,:';5 All Classes (15-16) << v
2= o
e | =
. Quiz 28 é@  AllClasses (15-18) o v
= & =)
0o ©
. Test o é&@  AllClasses (15-16) T W v
3
. Class Work = All Classes (15-16) U5 v
JG_IJ o W
8¢ g
- L.z All Classes (15-16 @
. Final Grade 55 ( ) < v
=8 o
W c All Classes (15-18 et
. Homework S ( ) = v
5° ©
. PTs - All Classes (15-16) v
Cancel E

Creating Assignments
PowerTeacher Pro offers a flexible way to create Assignments. Unlike PowerTeacher
Gradebook, Teachers can create assignments for multiple classes at once, they can link

assignment to a specific group of students as well as associate Standards to the
assignments.

signment
L
Category

Create an Assignment

1. Click on Create
2. Select Assignment from the drop-down list.
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On the next screen: _ﬂ

3. Cllck On the Assignments tab_ AAssignmsmt Students Standards Publish
Classes™ o Select Classes v
4. C||Ck On Select Classes. 1 Class: HR1{Mon-Fri) Homeroom Grade 4
(By default, the current/selected class will ~ assoment vame: 6 @
be checked. To add additional classes e e
check the box(es) for those classes.) Category - 6 st Gty |
5. Enter a unique Assignment Name. ‘Scmﬂ'@ e 0 o &
Score  +Extra Points | + Weight core Entry Points* 10
6. Select the Category to which you g @
wish to associate the assignment. Countn FnalGrade (11
(Note: The Values for Score Type, Descripton @ [TestonChapterd
Extra points, Score Entry Points,
Counts in Final Grade and Publish Options
will pull from the Category setup.
If different values are needed for a specific
Assignment, proceed with the steps below.) ® -
7. Select the Score Type for the Assignment. Options Include:
e Points
Percent

[ ]
e Letter Grade
e Collected Only

8. If Extra Credit will be associated to the assignment click on Extra Points and
then enter the appropriate number of extra credit points.

9. If the assignment will have a weight value other than 1, click on Weight and then
enter the correct weight for the assignment.

10. Enter the appropriate Score Entry Point value for the assignment.
11. Check the box if the assignment is to Count in Final Grade.
12. If desired enter a Description of the assignment.

13. Click Save to create the assignment and keep the Assignment window open.
(Helpful if you wish to duplicate the assignment) or Save and Close to close the
Assignment window. Regardless of which option is chosen a Message window will
appear indicating that the assignment has been saved and giving the user the
option to Score the assignment. Selecting this option will automatically take the
user to the Score Entry screen for the newly created assignment.

/ Assignment: Sample Assignment created successfully. Assignment| b 4 ‘

PREPARED BY: 29
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Create an Assignment for Select Students

If you wish to create an assignment for just a select group of students, you will follow
the directions as listed above to create the initial assignment. Once the assignment
information has been entered you will then do the following:

I
Assigno Students Standards Publish

Classes
2 Classes: English Language Arts Grade 4 [ 1(Fri) 2(Mon-Wed) 4(Thu). 1(Thu) 3(Mon-Tue, Fri)
4{Wed) ]

1. Click on the Students tab
2. Click on Add/Remove Students

3. Check/uncheck the box to the
right of *student’s names.

Show Selected Students Add/Remove Students 9 v

e Check = included

E The assignment applies to 58 out of 61 students. }

e Unchecked = excluded

*(If the assignment has been
linked to multiple sections all
students will appear in this one
list.)

4. Click Save to save the
assignment.

FILTER
m Accurso, John Dean
m Albanese, Gabriel

m Albano, Lauren

m Ambizas, Athena

X
1(Thu) 3{Mon-Tue,Fri) 4(\Wed) English Langua..
1(Fri) 2{Mon-Wed) 4{Thu) English Language A .
1(Thu) 3{Mon-Tue,Fri) 4(\Wed) English Langua..

1(Fri) 2{Mon-Wed) 4{Thu) English Language A..

:/"

Delete

Select Publish Options for an Assignment

PowerTeacher Pro gives you the option of if/when you wish to publish an assignment to
the Public Portals. These include the Quick Lookup screen in PowerSchool Admin and
PowerTeacher as well as the Parent/Student Portals. If left at the default, the
assignment will be visible to all Public Portals (as enabled from the Admin Side of
PowerSchool) as soon as the assignment is saved. Teachers do have other options as

well.

To set the Publish option for an assignment you will follow the directions as listed

above to create the initial assignment. Once the assignment information has been

entered you will then do the following:
Click on the Publish tab.

1. Select the appropriate Publish
option.
e Immediately - The
assignment appears when
the assignment is saved.
e On a Specific Date - Appears
on the date entered here.

PREPARED BY: 30
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e Days Before Date Due - Enter the number of days, before the due date,
that you want the assignment to appear.

e On Due Date - Assignment will appear on the assignment due date.

e Never - The assignment will not appear on any Public Portal. Be aware that
the assignment score will still average into the Final course grade even
though the assignment is not visible.

2. Check the box to Publish Scores. (If you do not publish scores, the Include in
Final Grade option must be unchecked for the assignment.)

3. Click Save or Save and Close to save the assignment.

Duplicate an Assignment

In addition to linking assignment to multiple classes upon creation, Teachers also have
the option to “"Duplicate” the setup from one Assignment to another. This is not the
same as the copy function currently in PowerTeacher Gradebook, but rather the ability
to take an existing assignment and duplicate all settings, to a second assignment, with a
new name. This can be done when initially creating assignments, or teachers can select
an assighment that already exists and duplicate. Note all settings from the original
assignment; Students, Standards, Publish, will be applied to the new assignment unless
changed during the creation process. The assignment name will be duplicated and an
extension of _1 will be added. Once the original assignment information has been
created you will then do the following:

If duplicating after creating the assignment.

1. Click Duplicate bottom right corner. A\ Posigoment | Students  Standrds | Publish
Classes” Select Classes L
2. Give the aSSignment a new name if 2 Classes: English Language Arts Grade 4 [ 1(Fri) 2(Mon-Wed) 4(Thu), 1(Thu) 3(on-Tue,Fri) 4(Wed)
desired. Otherwise the name will be ]
duplicated and an extension of _1 will L @ - ©
be added. e
Category * | v

3. Select how you want to assign the date

e Per Class - If the assignment is Seore e Pecent v
associated to more than one class, s.e v o [ 00
you can assign a different date for
eaCh Class Count in Final Grade /]

e Single Date - Assigns the same
date for all classes.

4. Enter the actual Date Due.
5. Give the assignment a Description.
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6. Click Save or Save and Close to save

the new assignment.

7. Click on the X in the upper right corner
to close the Assignment Window.

3. Help

Due Date” 9 omesday 11012017 =
Description oTest on Chapter 1 Material
)
o Duplicate Save Save and Close

The Help link allows access to several online Help Features. These include:

Help

Like the Help feature in PowerSchool, clicking on

PowerTeacher Pro Help
Tips and Tricks

Getting Started Outline
What's New

Video tutorials

Help

Tips and Tricks

Getting Started

What's New?

Videos

‘ PowerTeacher Pro Help

the Help link will open PowerTeacher Pro to the = o

Help Screen for the page on which you are currently R
Working. So, if you are on the Scoresheet it will

Comment Verification

B Navigating PowerTeacher Pro

take you to the help screen for the Scoresheet. If S Migraean o PonerIScher P
you are on Comment Verification it will take you to :i“‘“_"s:; N

. . thing for it Car . e charms bar. select Grac
the Help Screen Comment verification. If the Help [ " e the Ouick M 1o mavgn

screen opens to a topic for which you are not
interested, you can use the left menu to select a
topic or use the search function to navigate to the P Grading

appropriate information.

PREPARED BY:
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2. To add or edit a comment, sele

B Videos 3. Select the Comment icon in th
. . 4. Add comments for additional s

P Create Categories and Assignments 5 Select Save.

N Learn More

P Class Comment Bank

) Students Comment Log

P Progress

) Assessment
P Reports
P Settings
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Tips and Tricks
Tips and Tricks

The Tips and Tricks link will take to the section of

The Help Screens that offers directions on how to

Get the PowerTeacher Pro Quick Reference Card for more quick tips!

Compact View

Optimize your usage of PowerTeacher Pro. Show Hide Page Elements
Scroll Bars Invisible
Reports
Associate Assignments
Save Toner When Printing
Hot Keys

PowerSchool » 25 Homeroom - 16-17

Getting Started : i

.
Getting Started allows you Weicome to PowerTeacher Pro!
PowerTeacher Pro combines an intuitive user interface with robust functionality for
to access the welcome screen anaging i oo I 6o 1o i s foane for bl s
N based and traditional grading, PowerTeacher Pro improves tremendously on the previous
gradebook. It also provides the same great user experience and full functionality from any
for PowerTeacher Pro. . Computer o tabet, Inlucing e, Windous, 105, Andeid, anc Chrmébsels
Features include:
« Easy-to-use class progress graphs and charts
« Enhanced single student views, giving a 360-degree »
view of performance
- Quick access to assignment scoring
« Mark scores with Incomplete or Absent score codes
«» Training videos now included in Help! Watch the videos

here.
« Watch the What's new in PowerSchool 10.1 video to see all of the new features available

in PowerTeacher Prol

Welcome To
PowerTeacher Pro

What’'s New
Welcome to PowerTeacher Prol %

what’s New Wl“ ta ke you to a |ISt of the ” PowerTeacher Pro combines an intuitive user interface with robust functionality for

managing the classroom. In addition to providing advanced features for both standards-

Newest Featu res for the ve rS|0n Of based and traditional grading, PowerTeacher Pro improves tremendously on the previous

gradebook. It also provides the same great user experience and full functionality from any

Powe rTeaCher Pro you are USl ng . computer or tablet, including Mac, Windows, i0S, Android, and Chromebooks.

Features include:

Easy-to-use class progress graphs and charts
Enhanced single student views, giving a 360-degree >
view of performance

Quick access to assignment scoring

Mark scores with Incomplete or Absent score codes
Training videos now included in Help! Watch the videos
here.

Watch the What's new in PowerSchool 10.1 video to see all of the new features available
in PowerTeacher Pral

Welcome To
PowerTeacher Pro

Videos

Accessing the Video option will take you to the portion of
PowerTeacher Pro Help where you can access available Video Welcome To
tutorials on how different aspects of PowerTeacher Pro function. PowerTeacher Pro
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4. Sign Out/Accessibility Options | signout
Clicking on the Teacher’'s Name gives access to two options. -

First is the ability to Sign Out of PowerTeacher Pro. The second allows e
the user to select the View size of data in PowerTeacher Pro. There are | Small

now three options available, Small, Medium or Large. The smaller the
View selected the more information that will appear on the screen, the
larger the View selected the less information that will appear on the screen. Large
This setting applies to all applicable pages in PowerTeacher Pro.

Medium

Small View:
STUDENT (15 =
1. Andersen, Apaulo r 4 B3 58
2. Andersen, Ashley 3 BT
3. Becker, Jennifer F 2 ITET %
4. Bertram, Stacy 1 h18%
3. Bjorklund, Laura 3 Bo4gd
&. Blankenship, Jessica 3 B M
7. Booth, Chris 3 B
Medium View: Large View:
|
STUDENT (15) lk
trj Q1
r STUDENT (15)
m 1. Andersen, Apaulo 4
03.58% r =
m 2. Andersen, Ashley 3 m 1. Andersen, Apaulo 4
BT% 93.68%
m 3. Becker, Jennifer v 2 B
I7.57% m. 2. Andersen, Ashley 3
m 4. Bertram, Stacy 1 S
51.8% r
PREPARED BY: 34
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5. Options Gear

Click the options Gear £# to access Options menus. Functions available within the
menu will vary based on which screen the user is on when accessing the link. Available
options include:

GRADING =

Show Filter

e Grading > Assignments List

o Show/Hide Filter - allows you to turn the filter option, at the Copy Assignments
top of the screen, on or off.

o Copy Assignments - Allows you to copy assignments from a specific

term/class to a different class or group of classes for a specific term.
Teachers can also copy assignments, from PowerTeacher Gradebook,
however, when using this option teacher cannot select individual
assignments. ALL assignments from PowerTeacher Gradebook will copy to
PowerTeacher Pro. The teacher will then need to edit/delete assignments
that are not wanted.

How to Copy Assignments from PTP

From the Options Gear at the top right of the Assignment and/or Scoresheet
screen select the option to Copy Assignments.
Once on the Copy Assignment screen select the following:

From: Select the TERM and Class from the respective drop downs for the

From

Term

Class

PREPARED BY:

assignment(s) you wish to copy.

Semester 1 (18-17) n
Select Class H
2016-2017 [18-17)

25 2nd Grade English 1817

| Semester 1 (18-17)

25 2nd Grade Math 1817 N _
= ’ Semester 2 (15-17)

25 2nd Grade Science 18-17
25 2nd Grade Social Studies 1817

; [T Losic
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TO: Select the TERM and Class(es) from the respective drop downs for the term
and class for which you are copy the assignments into.

To

Term Select Scheduling Term n

Classes” Select All 2016-2017 [16-17)

ocl :
asses 25 2nd Grade English 18-17 Semester 1 (1817}

25 2nd Grade Math 1617 Semester 2 1817
25 2nd Grade Science 18-17
25 2nd Grade Social Studies 18-17

Copy Options:

Due Date: Select the Due date from one of the available options.
» Existing will use the original assignment date.
» Relational will use a date that is proportional to when the original
assignment was due as related to the term.
» Custom allows the user to assign a new due date.

Due Dates | Relational n

Existing

| Relational

Custom

Choose Assignments: Choose the assignment(s) you wish to copy from one
class to another. The user can select all assignments by
checking the box at the top left of the list or can select
individual assignment to copy by checking the individual
boxes to the left of each assignment.

Choose the Assignments

o= =T=)
5of 5 items
CATEGORY ASSIGNMENTS DUE DATE W SCORE TYPE
ome . Review apter’ 1e/2
1. Review Chapter? 1111612016 f‘ff“‘i
- Points
= 2. Test chpt 18 11152016 pts: 100
ﬂ 3. Homework Review 2 81252016 E”:’f;ﬁi‘e

Click Copy Assignments to complete the process

Hide Summary
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e Grading > Assignment List > Select an individual
Assignment

o Show/Hide Summary - allows you to show/hide the
assignment summary.

Assignment: Final Grade EdiAssigmeni  Show More
Score Type: Percent Score: 4 | 100% | 100100 Due: 10/17/2016

o Show/Hide Metrics - allows the user to turn on/off assignment metrics of
Mean, Median and Mode.

Mean 94.867
98

Median
Maode 98
STUDENTS (15} 'Y SCORE {:
(10/M7/2016)
m 1. Andersen, Apaulo 100

o Show/Hide Standards - allows the user to show/hide standards
associated to a given assignments.

STUDENTS (15) A SCORE o 2RLOZ 2RLO3
(2/2016)

m 1. Andersen, Apaulo 4 4 4

m 2. Andersen, Ashley 3 4 3

o Export Scores Template - allows the user to export an assignment as a
.csv file for grade entry outside of PowerSchool.

Export Scores Template

| E Include Scores? ‘

o Import Scores - allows the user to import scores from spreadsheet or
other application. T N TN

File Browse Files ChapterbTest_pst.csv (602 bytes)

Format [ PowerTeacher Score e |8

Validate Student Names I PowerTeacher Score Template

CSV (comma separated values)
Text (tab delimited)
Other
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Hide Filter

Grading > Scoresheet View Hide Summary

Hide Metrics

Copy Assignments

o Show/Hide Filter - allows you to turn the filter option, Show Assignments from Host Recert
at the top of the screen, on or off. | Recalculate Final Grages

Basic Filter =

Due Date Range Today This Week Last Week This Month Last Menth +

Clear || Apply

o Show/Hide Summary - allows you to show/hide the
assignment summary.

Assignment: Final Grade SMAssigment  Show Mare
Score Type: Percent Score: 4 | 100% | 100100 Due: 1011772016

o Show/Hide Metrics - allows the user to turn on/off assignment metrics of
Mean, Median and Mode.

Mean 94.867
98

Median

Mode: 98
STUDENTS (15) A SCORE 4
m 1. Andersen, Apaulo 100

o Copy Assignments - Allows you to copy assignments from a specific
term/class to a different class or group of classes for a specific term. (See
above for directions on how to Copy Assignments.)

o Show Assignments from Most/Least Recent - allows you to sort
assignments within the Scoresheet from newest to oldest or oldest to
newest.

o Recalculate Final Grades - allows you to recalculate Final Traditional or
Standards grades for the selected class(es).

Recalculate Final Grades

Classes™ Select Classes
1 Class: 2(A) 4th Grade English

Traditional Final Grades

Standards Final Grades

PREPARED BY: 38
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e Grading > Traditional, Comment Verification
or Reporting Terms

o Show/Hide Summary - allows you to show/hide the
Term summary.

Show Summary

Class Grade: Q3 Caleulation:
Grade Scale Type: (4-1) Grade:= - -

e Grading > Categories Totals Hide Fier
Hide Summary

Show Metrics

o Show/Hide Summary - allows you to show/hide the
Term summary.

Recalculate Final Grades

v
Class Grade: Q3 Calculation:
Grade Scale Type:(4-1) Grade:~ | - | -

o Show All Categories/Show Categories for this section - allows you to
view the category totals for All active categories or just the categories for
the selected class.

l 03 TEST e CHEGKLIST HOMERCRR GROUPPROUECT PROECTS MATH FACTS
STUDENT (15

1. Andersen, Apaulo - -

o Show/Hide Metrics - allows the user to turn on/off assignment metrics of
Mean, Median and Mode.

Mean 94.867
Median 98

Mode: 98
STUDENTS (15} 'Y SCORE {:
(10/M7/2016)
m 1. Andersen, Apaulo 100

o Recalculate Final Grades - allows you to recalculate Final Traditional or
Standards grades for the selected class(es).

Recalculate Final Grades

Classes* Select Classes H
1 Class: 2(A) 4th Grade English

Traditional Final Grades

Standards Final Grades
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STUDENTS e Fter

e Students > Assignments

Hide Summary

Hide Details

o Show/Hide Filter - allows the user to turn the filter option, ! i

at the top Of the Screen, on or Off_ | Recalculate Final Grades !

Basic Filter L3

Due Date Range Today This Week Last Week This Menth Last Month £

Clear  Apply

Show/Hide Summary - allows the user to show/hide the
assignment summary.

Class Grade: Q1 Calculation: Category Weighting
Grade Scale Type: (4- 1) Grade: 4 | 100% | -

Show/Hide Details - allows the user to show/hide specific details for the
selected student for the selected section. This information includes Final
Grade and attendance data for the student for the selected term.

v 4
= 93.68%

Absent: — Tardy: -- Missing: — Late: —

Recalculate Final Grades - allows you to recalculate Final Traditional or
Standards grades for the selected class(es).

Recalculate Final Grades

Classes* Select Classes
1 Class: 2(A) 4th Grade English

Traditional Final Grades

Standards Final Grades

e Students > Comment Log | Fide Fiter .

PREPARED BY:

Hide Summary

o Show/Hide Filter - allows the user to turn the filter option,

at the top of the screen, on or off.

Recalculate Final Grades
Assignments
[=T=)

o Show/Hide Summary - allows the user to show/hide the

Term summary.

Class Grade: Q1 Calculation: Category Weighting
Grade Scale Type: (4- 1) Grade: 4 | 100% | —

40 l
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o Recalculate Final Grades - allows you to recalculate Final Traditional or
Standards grades for the selected class(es).

Recalculate Final Grades

Classes™ Select Classes
1 Class: 2(A) 4th Grade English

® Traditional Final Grades

Standards Final Grades

51
] ]

a1 I
1 ]

6. Terms

The terms list will display all terms that have been configured 'l a2
under the Final Grade/Reporting Term Setup screen on the Admin '
side of PowerSchool. PowerTeacher Pro may default to the current

term depending on how the Default Term is setup on the Admin P
side. If the correct term is not selected when the teacher logs into a4
PowerTeacher Pro he/she can change the term by selecting it from

The list. o

The term selected will determine which assignment, grades and/or standard grade
information is displayed. Ex: If Q1 is selected only assignments, standards and grades
entered for assignments with a due date that falls within the Q1 term will appear.

Selecting ALL will allow the user to see a list of all assignments, standard and or grades
for the entire year.

7. Grading

Assignments
Under the Grading option a user can look at Traditional Grades Assignment List
on two levels. At the Assignment level and then at
the Final Grades level. At the Assignment level, teachers
can work with assignments one at a time or they Categories
can view/edit assignments by using the more traditional
Scoresheet view.

Scoresheet

Grades

Traditional

In addition, the Grading Section allows teachers to take a
closer look at final calculated grades, both traditional and
standards as well as view Final Grade Comments Comment Verfication
and Category totals.

Standards

Category Totals

All Reporting Terms

PREPARED BY: 41
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Assignments

Start > Grading > Assignment List > Select Assignment

Assignment List

. . A N ;
To get to the Assignment List cradn, | et
. . m dﬁ\smgnment List
1. Click on Grading from Students
Scoresheet
the Charms Bar. al
Hege= Categories

2. Click on Assignments.

3. Select the class for which you wish to view assignments.

U:” PowerSchool 3 » 1(Thu) 3(Mon-Tue,Fri) 4(Wed) English Language Arts Grade 4 - 15-16
. .
Al Assignments e T v
Grading
m » Filter | a I Clear I Apply I
Students
e 1-2 of 2 items
o CATEGORY  ASSIGNMENTS SCORED  DUEDATE w SCORETYPE  EDIT
Progress
5 H 1. Test Chapter 1 1730 411912016 ;?f{e‘;t 7
Reports 9 Grade Scal
= 2. Chapter 7 test 5130 4/8/2016 mgaweu e Va4
Settings.
@owssPage 10 e

4. Select the Reporting Term.

5. The List of assignments for the selected/class term will display.

6. Rows/Page shows the number of assignments visible on the page.

7. Edit the setup of an assignment by clicking on the pencil Icon in the Edit column.

8. Use the Filter option to limit the assignments shown. You can filter by any value
shown on the page (Category, Assignment name, date due, score type, etc), as
well as by Assignments that Need Scoring or are still Due.

To Work with the Assigment click on the Assignment Name.
E sample M@

Assignment: Sample
'Score Type: Points (10) Score: A | 100% | 10/10 Due: 7117/2017
Mean 8588
o Median 10
Mode 10

SCORE
STUDENTS (17) e 1712017)

A2 1. Allen, Victor 9
3P 2 Black, Javier 0
m 3. Clark, Gracie 5
P2 4. parrow, Kaylee
P2 5. Heide, Cody 7
PREPARED BY: 42
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1. The Information Bar gives the assignment setup information, Name, Score
Type, Possible Points, Date Due, etc.

2. Students - Lists students for whom the assignment is associated. Clicking the

arrow to the right will sort the students alphabetically A-Z or Z-A.

3. Score - Column used to enter the Traditional Assignment Score.

4. Metrics - If enabled would display the Mean, Median and Mode scores for each

assignment.

5. Edit Assignment - allows you to change the setup itme for this particular

assignment.

6. Show More - gives you a view of more information regarding this aSS|gnment

(See Below)

Assignment: Test Chapter 1
Score Type: Percent

Grade Scale Special Codes

Name: Grade 3-5 Rubric Scale

Score: - | — | /100

Description: Grade 35 Grade Scale for use by DRVC Elementary schools. Updated for use vith New Report Card Aug. 2013

GRADE LABEL
4

3
2
1

DESCRIPTION PERCENT CUTOFF
Thorough Understanding 90
Understanding 80
Partial Understanding 0

Minimal Understanding 60

Due: 4/19/2016

PERCENT VALUE
85

65

7. Clicking on the drop-down arrow, at the top left of the screen, allows you to switch
between assignments within the selected class.

Click the Save button to save any changes made through the Assignment Screen.

PREPARED BY:
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Score Sheet
Start > Grading > ScoreSheet

The ScoreSheet offers a more traditional view of the Teacher’s gradebook, for those
that are more comfortable with this type of grade entry.

Scoresheet - Q1 # «H
25 2nd Grade English

m Q1is already completed

ssignment: Test Chapter 1
Score Type: (4- 1) Score- 4 | 98% | B8/100x 035 Due: 82212018
2 > Filter [ Claarl Apply l

1-11 of 15 tems
WearB1.034% 3 3 3 2786 3 1 3
Median 85.22% 3 3 3 z 3 z 3
Mode 8522% 3 3 3 H 3 3
ENTETEIE cApE | TEST CHAPTE.. HOMEWORKC... HOMEWORK G... HOMEWORK R... TEST CHAPTEWWIEST CHAFTE... CHAPTER 10T... CHAPTER 6 TE.. CHAPTER 7 TE... CHAPTER 8 TE... CHAPTER 9 TE..
. ) . (8/122/2016) {E24/2016) {E24/2016) (E24/2016) (E124/2016) (@212016) (1017/2018)  (1017/2016) | (10(17/2018) | (10(7/2018)  (10/17/2016)
A§1 1. Ancersen, Apauio ro, 4 v 3 3 NA 4 4
93.68%
& 2 Andersen, Ashley 3 3 3 v 3 3
7%
" L4
Mt 3 Becker, Jennifer 2 WIS 3 4 3 2 3
37.57% 0%
M 4 Bertram, Stacy 2 3 3 4 MIS 3
T1.48% 0o
M 5 Biorkdund, Laura 3 3 3 4 4 3
7%
& 6. Blankenship, Jessica 3 3 3 4 Mi 3
85.29% avoe
& 7. Booth, Chris 3 3 3 4 3
85.25%
M & Brown, Jessica 3 3 3 2 3
85.22%
M o caid, Jessica 3 3 3 2 3
85.22%
AR 10 Dennis, Joshua 3 3 3 2 3
85.22%
Pt 1. Derbidge, Anthony 3 3 3 2 3
85.22%
At 12 Dewey, Adam 3 3 3 2 3
85.22%
At 13 Dossert, Christing 3 3 3 2 3
85.22%
A 14 Finley, Sandy 3 3 3 2 3
85.22%
A 15 Gahner, Matt 3 3 3 2 3
85.22%
Page (1 of 2 << < @ 2 = >= Columns/Page 11

® )
(Column Heading or Row Data) shown on the page or by Date Range (Todéy, This
Week, Last Week, This Month, Last Month).

3. Edit Assignment - Appears when you have clicked into the Grade Cell for a
particular assignment. This allows you to change the setup itme for this particular
assignment.

4. Show More - Will appear if you have clicked into the Grade Cell for a particular
assignment or if you have clicked into the Final Grade Cell or a student. The data
displayed will determine which type of Grade Cell you are in. If you are in the
Grade Cell for an Assignmet you will see information regarding this assignment.
(See Below)
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Assignment: Test Chapter 1
Score Type: Percent Score: — | — | 100 Due: 4192016
Grade Scale | Special Codes

Name: Grade 3-5 Rubric Scale
Description: Grade 36 Grade Scale for use by DRVC Elementary schools. Updated for use with New Report Card Aug. 2013

GRADE LABEL DESCRIPTION PERCENT CUTOFF PERCENT VALUE
Thorough Understanding %0 9%

3 Understanding 80 85

2 Partial Understanding 70 75

1 Ninimal Understanding 60 65

If you are in the Final Grade Cell for a student you will see information regarding the
Class Setup. This contains information on Grade Scales, Special Codes and Formulas for
how the Final Grade for the class is being calculated. (See Below)

a. Grade Scales - The Grade Scale Assigned to the Class

Class Grade: T3 Calculation: Category Weighting

Grade Scale Type: Alpha (4 - 1) Grade: 4 | 100% | —

Grade Scale Special Codes Formula

Name: Grade 3-5 Rubric Scale
ipti 3.5 Grade Scale for use by Elementary schools. Updated for use with New Report Card Aug. 2013
GRADE LABEL DESCRIPTION PERCENT CUTOFF PERCENT VALUE

4 Thorough Understanding 90 95
3 Understanding 80 85
2 Patial Understanding 70 75
1 Minimal Understanding 60 65

b. Special Codes - These are any Special Character / Grade Codes that are
being used by the course but are not part of the regular grade scale.

Class Grade: T3 Calculation: Category Weighting Show Less

Grade Scale Type: Alpha (4 - 1) Grade: 4 | 100% | —

Grade Scale Special Codes Formula

NAME DESCRIPTION VALUE FLAGS

INC Incomplete 50 (Exempt) o

c. Formula - This is the calculation method being used to calculate the Final
Course grade for the term selected.

Class Grade: T3 Calculation: Category Weighting Show Less
Grade Scale Type: Alpha (4 - 1) Grade: 4 | 100% | —

Grade Scale Special Codes Formula

T3: Category Weighting

TYPE ATTRIBUTE WEIGHT PERCENT
Category Weighting . Classwork & |1 25%
Category Weighting . Homework B | 1 25%
Category Weighting . Quiz @ |1 25%
Category Weighting . Test e 1 25%

5. Metrics - If enabled would display the Mean, Median and Mode scores for each
assignment within the Scoresheet, as well as for the Final Course Grade.

6. Students - List of students enrolled in the selected class.
7. Grade - This is the final calculated grade for selected term.
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8. Assignments/scores contributing to Final Grade for selected Term.

9. Move to the Next Page — Within the Scoresheet view, Teachers can set the
number of assignment columns visible on the page. Currently, the maximum
number of columns that can be displayed at one time is 20. If more assignments
have been created PowerTeacher Pro will start to Paginate. To move to the next
page, you can click on the Arrow to the upper right of the last column. To move
back click on the arrow to left of the first column.

While the Max number of columns that can be viewed on a given page is 20,
setting the value to a number higher than 12 will require the Teacher to use the
scroll bar at the bottom of the screen. Note that in doing so the student names
are not locked and when scrolling to the right you will no longer be able to see
your class list.

10. Pagination - As indicated above, PowerTeacher Pro now uses pagination to
move through assignments within the Score Sheet. You can either Type the page
number to which you want to move or use the arrows to move through the page.
You can also set the Max # of columns to display on the page. As noted above, if
set to anything greater than 12 columns the user need to scroll left to right. In
doing so the Student names will not remain static and you will lose the ability to
see student names.

11. Click the Save button to save any changes made through the Score Sheet.
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Categories
Start > Grading > Categories

The Categories screen under the Grading section is similar to the View All tab under
Create > Category with some additional functionality.

Categories e Show Inactive

o ORDER COLOR  CATEGORY NAME 0 CLASSES USING e ACTIVE oEEHT@

Classwork £ All Classes (15-16) v /
Project 3 All Classes (15-16)
Quiz & All Classes (15-16)
Test 2 All Classes (15-18)
Class Work All Classes (15-16)
Final Grade All Classes (15-16)
Homework All Classes (15-16)

PTs All Classes (15-16)

>
4

A N R N N
NESEISNISES IS S

Collected items 1 Class: 1(Thu) 3(Mon-Tue,Fri) 4(Wed) English Language Arts Grade 4

1. Order - You can sort the order in which your categories are listed when creating
assignments by using the arrows to move them up/down.

2. Color - Color is assigned when the cateogry is created. Assignments, when
viewed in the score sheet, will be color coded based on the category assigned.

3. Category Name - Name given to the Category. Category Names must be unique.

4. Category Icon - If categories are created at the District Level and pushed out to
users the Category Name column will display an icon of a school building. Any
Categoryies without this icon have been created by the teacher within his/her
gradebook.

5. Classes Using - This section will list what classes are using this category. When
in this screen or in the View All under Category setup you will see ALL Categories.
However, when creating assignmenst only categories associaed to all classes and
that specific class will be available for selection.

6. Active - This indicates if a category is Active or not. It is not possible to delete

categories that have previously been used, but you can make them inactive so
that they are not visible in the current Year. See the section on Editing below.
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7. Edit - This screen allows you to modify

the setup for a specific category. This
screen is the same as the original Create o | Motee | 2
Category Screen as discussed earlier. [E Classes where you are the lead teacher are available for this category. ]
Limit this category to these classes Select Classes v
8. Show Inactive - If checked the user e
can see both active and inactive standards.| "™ e
Color 5.
Status Active @ Inactive
Description
—
PREPARED BY: 48
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Grades

Traditional

Start > Grading > Grades > Traditional

The Grades > Traditional Screen shows overall information for a selected term. This
screen includes not only the Calculated Final Grade for the selected term, but also
accumulated attendance and then any assignments that may be flagged as Late, Missing
or Incomplete.

Grades: Traditional - Q2 o p—
5(A) Science

alass Grads: Q2 Caleulgfion: Category Weighting
rade Scale Type: (A - F) 6 Grade: B | B2% o e
VARIABLE CREDIT 6 ATTENDANCE ASSIGNMENTS
DENT e o Qaz

froesT —zoreo TEEEEE 0 ABSENCES 0 TARDEES o MISSING o LATE Q INCOMPLETE
1. Booth, Chris 5 503 - - - 1 -
2. Brown, Jessica Towa 8o
3. Coffey, Raul 100%
4. Gahner, Matt at
5. Gall, Brady T4
6. Goodrich, Joshua B0%
7 100%
8 o
58%
20%
as%
100%
s1%
100%
To%
50%
20%
100%
88%

1

1 1

. Henderson, Aaron 1
1

10. Klinger, Joshua

11. Koller, Bryan

12. Lang, Vicki

13, Miller, Andy

14. Moen, Erin

15. Peters, Jennifer
16. Stephenson, Jessica
17. Straatman, Brandon
12. Watts, Charise

19. Zuniga, Trevor

mEmTMOPEPmEEDOORDO R >

e v Final Grade Status

1. Grades - You can switch to the other “"Grades” screens from within this view.
Options include:
e Traditional - Final Course grades
e Standards - Final Standards grades Standards
e Comment Verification - One page view of all
Final Grade Comments for the selected term.
e Category Totals - Totals for students by category. Category Totals
e All Reporting Terms - Final Course grades for all
Reporting Terms.

I Traditional

Comment Verification

All Reporting Terms

2. The Information Bar on this screen will change depending on the column you are
working in. By default, it contains the same information found in the Scoresheet
view including: Term, Calculation Method, Grade Scale, Grade/Earned
Points/Possible Points for the selected student. When working in the
Citizenship column the values change to include: Term, Grade Scale and Grade.
Clicking on Show More allows more information regarding the Grade Setup for
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the class. As above, the available information will depend of whether you are

looking at the Final Traditional Grade or the Citizenship grade. Available
information to view includes:

e Grade Scales - The Grade Scale Assigned to the Class

Description: The district defined ciizanship codes.
GRADE LABEL
f
s
N
u

DESCRIPTION

e Special Codes - These are any Special Character / Grade Codes that are
being used by the course but are not part of the regular grade scale.

Class Grade: T3 Calculation: Category Weighting

Grade Scale Type: Alpha (4- 1) Grade: 4 | 100% | —

Grade Scale Special Codes Formula

NAME DESCRIPTION VALUE FLAGS

INC Incomplete 50 (Exempt) (=

e Formula - This is the calculation method being used to calculate the Final
Course grade for the term selected.

Class Grade: T3 Calculation: Category Weighting

Grade Scale Type: Alpha (4- 1) Grade: 4 | 100% | —

Grade Scale Special Codes Formula

T3: Category Weighting
TYPE ATTRIBUTE WEIGHT

PERCENT
Category Weighting [l crasswork @ |1 259
Category Weighting [l Homeuwork & 1 259
Category Weighting . Quiz @ |1 25%
Category Weighting | @ 1 259

e Citizenhip - This includes the Citizenship Grade Scale.

Citizenship

Name: Citizenship

Description: The distrit defined citizenship codes.

GRADE LABEL DESCRIPTION
H Hanorable

s Safisfactory

N Needs {0 improve
U Unsatisfactory

3. Student Names - The list of students enrolled into the selected class or group of
classes.

4. Final Grades - Shows the Final Grade (either calculated or manually overwritten)
for the selected term. See the section on Entering Grades.
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5. Variable Credit - Use this screen to enter the appropriate Variable Credit
values for each student. Note, for these columns to appear, Variable Credit
musts be enabled at the section level on the Admin Side of PowerSchool. Within
each section, schools can enable the option to allow for Variable Credit Awarded,
Attempted or both.

6. Citizenship - Use this screen to enter the appropriate Citizenship code for each
student by clicking into the grade cell in the in the Citizenship column and entering
the appropriate score.

7. Attendance shows the total number of absences or tardy codes for the selected
term.

8. Assignments shows the total number of assignments that have been flagged as
either Missing, Incomplete or Late.

9. Final Grade Status is used at the end of the term for teachers to identify that
they have completed grade entry for the selected class. By clicking on the button,
a new window will open.

Teachers will check the box in the upper right indicating that the Final Grades for
the selected Term are complete. They can also enter a comment regarding the
Final Grades for the selected class. This information can then be view via the
Section Readiness Report from the Admin Portal.

Q1 Final Grade Status X

Q1 Final Grades are Complete

Comment

Click Save to save any changes made to the current page

Comment Verification

Start > Grading > Grades > Comment Verification

Comment Verification allows a user to see Final Class Grades as well as Final Grade
Comments in one place. As with similar screens, the teacher can look at a single class,
group of classes, or ALL classes in one location. In addition, Final Grades and
Comments can be manually entered/overwritten from this screen. See the section
below on Entering/Editing Grades and Comments. As with the Traditional screen,
Teachers can also indicate that they have completed working with Final Grades.
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Grades: Comment Verification - T3 ~ Blv

1(Thu) 3(Mon-Tue.Fri) 4(Wed) English Language Arts Grade 4

lass Grad ation: Total Points

Grade Scale Type: Alpha (4- 1) Grade: 4 | S3% | 1851 200

STUDENT (30 T COMMENT

ARt 1. Accurso, John Dean 4 ®| Johnis working well this trimester.
iy 2 Albano, Lauren 3
B5%
e i
ARt 3 Atinson, Sean 2 Sean nesds to spend mors tims reviswing for tests,

i ot working to her ability at this time

M 4 Aze, Wya

A 5. Blonc, Mikayla 3

Category Totals

Start > Grading > Grades > Category Totals

The Category Totals screen allows the user to view the Final Calculated Course score
as well as the calculated total for all Categories used throughout the marking period. If
Category Weights are being used this gives users a good view of how the Final Grade
has been calculated. As with similar screens the Information Bar at the top can be
expanded to show which Grade Scale(s) have been associated to the course as well as
the calculation method for the class. As with other Screens that show the Final Course
grades, the final grade can be manually overwritten from this screen.

Grades: Category Totals - T3 ~
1(Thu) 3(Mon-Tue, Fri) 4(Wed) English Language Arts Grade 4

sde: T3 Calculation: Total Point
‘ Grade Scale Type: Alpha (4 - 1) Grade: 4 | 93% | 185/ 200

STUDENT (30)

At 1. Accurso, John Dean s 4

A 2 Albano, Lauren 3 =

5% 5
A1 3 Atdnson, Sean 2 - - - 2
M 4 Azets, Wya 1 A
A 5 Blanc, Mkayla 3

At . Cantore, Anthony

All Reporting Terms

Start > Grading > Grades > All Reporting Terms

A similar screen to both the Traditional Grade, Comment Verification and Category
Totals screen, the All Reporting Terms screen displays the Final Traditional (Course)
grade for each Reporting term, for the selected year. As with all screens that display
Final Grades, this too, will show if a grade has been manually overwritten by displaying
a gray triangle in the upper left corner of the grade cell. Likewise, if a comment has
been entered there will be a blue comment balloon in the upper right. See the section
below Entering/Editing Grades and Comments for further directions.
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Grades: All Reporting Terms - T3 v N
1(Thu) 3(Mon-Tue,Fri) 4(Wed) English Language Arts Grade 4
Class Grade: T1 Calculation: Total Points
Grade Scale Type: Alpha (4- 1) Grade: 3 | 85% | 86/ 100
STUDENT (30) n " "
i’ 3 4 4
1. Accurso, John Dean
m 85% 95% 93%
4 4
e 2. Abano, Lauren 3 3 ki
85% 85% 85%
v v ]
it 3. Atkinson, Sean 3 3 z
85% 85% 5%
v 3 L4 3 a |
4. Azueta, Mya
m 5 85% 85% 65%
i’ 2 " 2 3
5. Blanc, Mikayla
m v 75% 5% 85%
r v
2 6. Cantore, Anthony 3 H -
85% 85% -

Students

Assignments

Start > Students > Assignments

This screen allows a user to view/edit multiple assignments scores, for a single student,
at one time. This option can include assignments for a single class or multiple classes
depending on the class or group of classes selected.

PowerSchool 1 » 25 2nd Grade English - 16-17 Qcreate @ L scehal

.m. Andersen, Apaulo - Assignments u 9 - SRR u

13 Course Grades

4
25 2nd Grade English e 98%

Assignments

ssignment: Test EdRAssigNment  ShawMare

Score Type: Percent Score: - | - | --/100 Due: 3132017

[=]=]
- -
1-2 of 2 items o e 9

ASSIGNMENT 0 SCORE DUEDATE w STANDARDS
1. Test 311312017 ]
2‘ Sample Assignment a8 31132017 o |-.u!

Rows/Page [100

1. The class selected at the top of the screen will determine which assignments are
visible. If a single class is selected, only the assignments for that class will be
available. If a group of classes is selected, all assignments for that group of
classes will be available.

2. Student Name - Allows the user the ability to select a different student or switch
to a different screen within the Student menu.
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3. Details - This section shows specific detail information about this student for the
class/classes selected. If shown, it will include the Name and Section # of the
course, the Overall Grade for the course, accumulated attendance totals, as well
as the total number of Missing or Late assignments.

4. The Information Bar gives the assignment setup information, Name, Score
Type, Possible Points, Date Due, etc. As with the Class Assignment screen
the Information Bar also allows a user to Edit Assignments directly from this
screen or select the Show More option to see Grade Scale information for each
assignnment.

5. Use the Filter option to limit the assignments shown. You can filter by any value
(Column Heading or Row Data) shown on the page or by Date Range (Today, This
Week, Last Week, This Month, Last Month).

6. Assignment List - List of Assignments and associated Categories. The list will
inlclude assignmetns based on the class or group of classes selected at the top of
the screen.

7. Score - Use this column to Ener/View/Edit the student’s score for each
assignment.

8. Due Date - Displays the due date for each assignment.
9. Standards - Displays the number of standards associated to the selected
Assignment. Clicking on the link will allow you to view the associated standards

and scores. Note that Standards Scores cannot be entered or edited from this
screen.
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Comment Log

Start > Students > Comment Log

The Comment Log is a screen that can be used to see ALL comments (both assignment
and final grade) entered, for a student, for the selected term. As will similar screens the
Filter can be used to filter down to a specific comment and the Information bar at the
top can be expanded to show which Grade Scale(s) have been associated to the course
as well as the calculation method for the class. As with other Screens that show the
Final Course grades, the final grade can be manually overwritten from this screen.

m Azueta, Mya - Comment Log + @ v

r
» Filter 2 I Clear l Apply l

3 of 3 items

Class Grade: T3 Calculation: Total Points e
Grade Scale Type: Alpha (4 - 1) Grade: 3 | 83% | 250/ 300

o TYPE/CATEGORY eCOMI'v‘\ENT TEXT G GRADE / SCORE eDATE v

Class Grade: T3 3 =
Mya is not working to her ability at this time 83%

T3

a
Worksheet 38
P9 90

11/ 6
Working will this term “IRRIEAL

Chapter 7 test 1 =

4/8/2016
Mya was not having a good day. She can retake the test on Friday N

Odde

Legend
lcons [ - Assignment m - Class Grade @ - Standard Grade <

1. Switch between Students and or screens within the Student View.
2. Use the Filter to narrow the results to a specific comment(s).

3. Information Bar that shows basic information about the course such as
Calculation Method, Score Type, and Grade.

4. Type/Category shows the type of Comment (either Final Grade or Assignment).
If a Final Gade comment it will display as Class Grade with the Appropriate Term.
If an Assignment comment it will show the category to which the assignment is
associated.

5. Comment Text shows the Name of the Term or Assignment as well as the text of
the comment itself.

6. Grade/Score displays the earned score for the term/assignment. As with other
Screens that show the Final Course grades, the final grade can be manually
overwritten from this screen.

7. Date shows the Date of the Assignment/Term of the final Grade comment.
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Demographics

Start > Students > Demographics

The Demographics page allows teachers to see basic demographic information for each

student. The information available has been entered through PS Admin. Teachers are
not able to enter/update any information contained on this page.

# Albanese, Gabriel - Demographics

Hame jLact Firct M
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Quick Lookup

Start > Students > Quick Lookup

The Quick Lookup Screen is available to both Admin Users and Teachers. This option
gives teachers a single screen where they can view student progress and attendance for

ALL classes in which a student is enrolled.

From the Quick Lookup screen a teacher can:
e Email another teacher.

e See Attendance totals (absent and tardy) by class, as a total for all classes,
or if enabled by the school the total Daily Attendance.

e Click into the Final Term grade and view the Scores Detail screen.

e This view can include both current enroliment as well as dropped classes.

. . o
Andersen, Apaulo - Quick Lookup - Traditional ﬂo
Aenciance By Class 3 o ©
Exp Last Week This Week Course a1 Q2 S1 a3 Q4 s2 Absences Tardies
M T w H F M T w H F s2 1617 52 16-17
1(A) eHDmBmDm [i [i [i [i [i [i 1] 1] 0 0
Clayton, Kathy A - Rm: 20
AN Homeroom 4 i 4 il [i il 0 1 0 1
Cahall, Lisa 100 100
2(A) 2nd Grade English A A A A A A 1] 1] 0 0
Clayton, Kathy A - Rm: 20 100 98 99 100 93.39 100
2(A) eznu Grade English 4 4 4 4 [i 4 0 0 0 0
Cahall, Lisa 93.68 98 95.84 98 98
H
3(A) o 2nd Grade Math A A A A A A ] ] 0 0
Clayton, Kathy A- Rm: 20 97 100 99 a8 100 99
3(4) Ind Grade Math 3 4 4 Iil [i Iil 0 0 0 0
Cahall, Lisa 89.54 105 97.271
4(A) 2nd Grade Social Studies B B B B A A ] ] 0 0
Clayton, Kathy A- Rm: 20 88 88 88 a5 100 91
4(4) 2nd Grade Secial Studies li1 [i 3 [i [i [i 0 0 0 0
Cahall, Lisa 87
5(A) 2nd Grade Science A A A A A A ] ] 0 0
Clayton, Kathy A- Rm: 20 100 100 100 100 100 100
5(4) 2nd Grade Science 4 [i 3 [i [i [i 0 0 0 0
Cahall, Lisa 98 87
8(A) Physical Education F F F F B F 0 0 0 0
Riley, Kourtney W - Rm: Gym 9 9 9 9 81.67 9
Attendance Totals o 1 o 1

Current weighted GPA (51): 2.8333 e

Show dropped classes also

1. Use this link to switch to a different student or switch to a different screen within
the Student View.

e Switch Students - Click the Student name from

| A Bianc, Mikayla
the left column.

Quick Lookup

e Switch Screens (within the Student View) - Click on
the name of the screen from the
right column.
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2. Email a teacher - Click on the Name of the teacher to
Open up your default email editor.

3. Final Term Grades - These columns show the Final

Grade for each class for their respective term. Clicking on the Final Grade will
take you to the Scores Detail Screen for that class.

4. Absences - These columns show the total Absences, to date, for the specified
terms.

5. Tardies - These columns show the total Tardies, to date, for the specified terms.

6. Attendance Totals - Show the total number of Absences and/or Tardies for all
classes for the specified terms.

7. Two Week Attendance - These columns show the individual attendance codes
entered for each class from the most recent two-week period.

Attendance By Day
Last Week Tnlswue Absences @ Tardies. 0
M T

w H F M T w H F 1516 ¥TD 15-16 YD

8. Show Dropped classes also - Click on this link if you wish to view information
for classes from a student has been dropped.

If Daily Attendance is being used by the school (this only works if using a Bridge Period
for Attendance), the Attendance by Day section will appear on the Quick Lookup screen.

9. Last Week - This will show the individual codes entered for the student for the
previous two-week period.

10. Absences - This column shows the total Daily Absences, to date, for the
specified terms.

11. Tardies - These columns show the total Daily Tardies, to date, for the specified
terms.
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Score Detail

The Score Detail screen offers detailed information explaining how a student’s grade has
been earned.

# Azueta, Mya - Quick Lookup vo

TEACeEs

e - S
© 0 Qo@

0 m sxcc@

cant ) - stantacs () - s Descrnon [ -vas Commant () - coectes () -Lace () - rissig ) - Sxemot s et e £ - Assen Q) - wcommiete ([ - Sxciutes

1. Use this link to either changes students or to change screens within the Student
View.

2. This is the Overall Course/Grade information and contains the name of the course,
teacher name, expression (period/day when class meets) and the Overall Final
Grade for the specified term.

3. Teacher Comment is the Final Grade Teacher comment for the selected student
for the specified term.

4. Section Description is used by the teacher to give general information regarding
the class. This information can be updated as needed by the teacher within the
Gradebook.

5. Date Due gives the date the assignment was given.

6. Category indicates the Teacher Category to which the assignment is associated

7. Assignment Name gives the name of each assignment.

8. Codes is a set of columns that can display various items pertaining to grades and /
or codes entered for each assignment.
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° @ - Standards

- Indicates that Standards have been associated to the

assignment. Click on the Icon to see the associated
standards and scores.

° a - Collected

has been issued.

° o - Late

° - Missing

- Indicates that the assignment has been collected but no score

- Indicates the assignment was turned in late.

- Indicates that the assignment has not been turned in.

. Q.Er.e.rptfm.r Fnal Grade - Indicates that the student is exempt from the

assignment.

° Q - Absent

was collected.

° 0 - Incomplete

submitted.

° - Excluded

- Indicates that the student was absent when the assignment

- Indicates that the assignment was incomplete when

- Indicates that the assignment is not being counted towards the

final grade for the course.

9. Score - is the actual score of the assignment and shows both Possible and Earned

points.

10. Grade is the earned letter grade based on the score for the assignment.

11. The last column indicates if there is an Individual Assignment Comment and /
or a Description on the Category or Assignment itself. If either have been
entered theword VIEW will appear. Click on View to see the associated comments

/descriptions.

Score Comment:
- Has Commeni

Student Score Detail n

Assignment Chapter 7 test

Category / Test

Score Comment Assignment Description

Mya was not having a good day. She can retake the test on Friday.
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Assignment Description:
- Has Description

Student Score Detail X

Chapter 7 test

/ Test

Assignment Description

Assignment

Category

Score Comment

Chapter test covering all of Chapter 7 - Imegular Verbs.
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Progress

Traditional

Start > Progress > Traditional

The Progress > Traditional Screen shows grade distribution, for the selected

class(es), for the selected term. Additionally, you can see the accumulated number
Missing, Late or Incomplete Assignments.

Traditional Grades Progress v

English Language Arts Grade 4 (T2) o 9

4 0 =
2 8 30 (9 Late
0 o
1 2 Incomplete

0

0]

o)

1. The Graph shows the distribution of grades (based on the associated
Grade Scale) for the selected class/classes. Clicking on any of the
lines on the graph will take you to a new, more detailed Distribution
Screen. This screen will show you:

B Engish Language Ats Grads 4
Class grade trends in T3 compared against T2
GRADE
SCORE DISTRIBUTION
o STUDENTS 9 EEl iF)
30 Atkinson, Sean 3 3
" i
0
A Azueta Wy s ® 3
30 -
T2 A Blanc, Mikayla 4 ® 2
0
A Cantore, Anthony 4 @ 3
30
LE] 5 A Caputo, Salvatore 4 @ 3
AR Doft, Alexa 4 @ 3
30
F1
0 @ Donnelly, Emily s @ 3
m Enea, Ava 4 4
OK

1. Score Distsribution for Each Term shows the distribution of grades (by
color) for each Term of the Year. The current Term will be highlighted.

2. The Student / Grade area will show each student with the current term
grade as well as the previous term grade. Additionally, an arrow indicator
(Green or Red) will appear, between the term grades,to show whether the
student has improved or declined since the previous term.
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o
x

3. The Settings Gear can be used to define

what appears in the Grades columnn of Scores -+ “"@"EmPy e
Distribution View. The user has the ability to | show Trena
select whether or not to show: ! trend compared against

I =
= Show Empty Grades - Display students I - °

even if they do not have a final grade for
the current term.
= Show Trend - Show the Green/Red arrow | F1
to indicate if a student has imporved or
declined as compared to the selected term.
* Trend Compared Against- Select the term against which you would like
to compare the current term’s final grade.

2. The Missing, Late, Incomplete boxes show the total number of
assignments within each category for the selected class. Clicking on
the any of these boxes will take the user to the Grades > Traditional
Screen where the Teacher can then see which students have Missing,
Late or Incomplete Assignements.

Grades: Traditional - T3 ~

1(Thu) 3(Mon-Tue,Fri) 4(Wed) English Language Arts Grade 4

Class Grade: T3 Calculation: Total Points
Grade Scale Type: Alpha (4- 1) Grade: 4 | 96% | 715/ 800
ATTENDANCE ASSIGNMENTS
STUDENT (30) T3 0 ABSENCES 0 TARDIES o MISSING o LATE 0 INCOMPLETE
4 =
m 1. Accurso, John Dean 4
96%
r
m 2. Albano, Lauren 4 = = 1 1 1
100%
=
m 3. Atkinson, Sean 3 - - 1 3 1
88%
a
m 4. Azueta, Mya 4 = = = 1 1
90%
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In PowerSchool Version 10.1.2 PowerTeacher Pro comes with four built in reports. They
include the Individual Student Report, the Multi-Function Report, the Scoresheet
Report and the Student Roster Report. When configuring any report in PTP the users
will need to navigate through three different screens.

1. Criteria - Use this screen to determine the specific student data to be
included in the report.

2. Students - Use this screen to select the student(s) for whom the report
will be run.

3. Format - Uses this screen to set the formatting of the report including
orientation, output type, top note, bottom note, etc.

Individual Student Report

Start > Reports > Individual Student Report

The Individual Student Report is a report than can be generated either for a single
student or group of students. It can be used as a Progress Report, a report to list
missing/late assignments, low grades, high grades, category totals or any combination
of these items.

Criteria - On the Criteria tab users will need to identify the following:

1. Report Title - By default this report is called the “Individual Student Report” but
it can be renamed.

2. Classes - Select the class/classes for which you want the report to run. For
multiple classes click on the drop down and then check the box for the selected
classes.

3. Use Custom Classes — Check the box to use the teacher define Custom Display
Name for each section.

4. Include Students’ Full Schedule - Check the box to include grade information
for all classes a student is enrolled in, not just the classes within the specific
Teacher’s gradebook.

5. Separate Report By Section, By Student/Separate Report by Student -
Check the box to break out the report to a separate page for each section per
student. This option will return a .zip file with a separate report for each section
for each student. (multiple files per student)
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If using the Include Student’s Full Schedule option then this option changes to
Separate Report by Student. This option will return a .zip file with one report
per student.

Depending on the options selected, there are times that you will be required to use
this option. If not selected PowerTeacher Pro will be unable to run the report
because of size limitations.

If not selected the report will generate a single report that page breaks on each
student.

6. Sort Options
e Layout - Select how you would like the finished reports to sort.
Options include:
o By section and then Student Name
o By Student Name

e Students - Select the order in which you would like the results sorted.
Options include:
o Gradebook Preference
olLast Name,
o First Name
o Student Number
e Assignments - Select how you want the Assignments sorted.
Options include:
o Due Date (Newest First)
o Due Date (Oldest First)
o Category and then Due Date (Newest First)
o Category and then Due Date (Latest First)

7. Data - What data would you like included in your report?
e Areas to include - These options can be used in any combination

o Course Grades and Attendance
e Course Grade Comments (Only available if Course Grades and
Attendance is selected.)
e Citizenship (Only available if Course Grades and Attendance is
selected.)
o Standards Final Grades (Will list all standards graded and ungraded)
o Assignments
e Assignment Comments (Only available if Assignments is
selected.)
e Standard Scores (Only available if Assignments is selected.)
o Category Totals
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e Show Percentages - Check to include, uncheck to exclude.
e Show Assignments with No Data - Check to include, uncheck to exclude.
e Include Standard Identifier - Check to include, uncheck to exclude.

e Include Student Number with Student Name - Check to include,
uncheck to exclude.

8. Date Range - Date Range options will appear based on the options you chose
under Data > Areas to Include.

e Standards/Course Grades - Select the Term(s) for which you want Final
Standards and/or Course Grades to appear. You can select ALL Terms or
you can specify term(s). If no term is selected it will default to the current
term.

e Assignment Date Range - Select the date range for which you would like
to include assignments.
Options include:

o Full Class - Includes assignments for the entire length of the class to
date.

o Manual - Enter a Start and End date for the assignments you wish to
include

o Individual Reporting Term - Select the specific Term for which you
want to print assignments.

e Categories Totals- Select the date range for which you would like to
include category totals. You can select ALL Terms, a specific Reporting Term
or group of terms.

9. Data Filters

e Assignment Attributes - Determine which type of categories you would
like to include. The user can select any combination of Attributes.
Options include:

o Missing

Late

Incomplete

Collected

Absent

Exempt

Blank Grade (excluding Exempt)

Has Comments

O O O O 0O O O
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e Assignment Scores - There are various options for selection the type of
scores to report. Depending on the option selected additional input will be
required.

@)
©)

No Filter = Includes all Assignment scores.

Grade Range - If selected identify the Max and Min Letter Grade a
student can have earned on assignments.

Percent Range - If selected identify the Max and Min Percentage
Grade a student can have earned on assignments

Color Level Range- If selected identify the Max and Min Color (as
determined by the Grade Scale) student can have earned on
assignments

Specific Grades - If selected, choose the specific grade/grades a
student can have earned on assignments

e Assignment Categories - Select the category/categories for which you
would like include assignments on this report.

e Course Grades - If Selected use the same options as offered under
Assignment scores above.

(@]

o

Grade Range - If selected identify the Max and Min Letter Grade a
student can have earned on assignments.

Percent Range - If selected identify the Max and Min Percentage
Grade a student can have earned on assignments

Color Level Range- If selected identify the Max and Min Color (as
determined by the Grade Scale) student can have earned on
assignments

Specific Grades - If selected, choose the specific grade/grades a
student can have earned on assignments

e Citizenship Grades - If Selected use the same options as offered under
Assignment scores above.

@)
©)

PREPARED BY:

No Filter = Includes all Citizenship scores.

Grade Range - If selected identify the Max and Min Citizenship score
a student can have earned on assignments.

Specific Grades - If selected, choose the specific Citizenship
grade/grades a student can have earned.
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Criteria Studanis Format

Report Title Individual Student Report
DE,‘SCleiOI’l Multi-function report per student. Useful for progress repors, missing/late assignments, low grades. high grades, category fotals, and more.
Classes™ Select Classes 1 Class: 4{A) 2nd Grade Social Studies

Use Custom Class Name

Include Students' Full Schedule Full schedule of classes for students within Date Range for Course Grades andior Assignments

Recommended if you are generating a large repon.

Separate Report By Student

Sort Options

Layout By Student

Students Last Name

Assignments Due Date (Newest First)

Data

Areas to Include™ Select Data Course Grades and Attendance, Standards Final Grades
Show Percentages

Show Assignments with no Data

Include Standards |dentifier

Include Student Number with Student Name

Date Range

Standards/Final Course Grades Select Reporting Term B

Data Filters

Course Grades Filter Grades Any Course Grades
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Students - On the Students Tab users will need to select the Student/Students for
whom the report needs to be run.

By default, the report will run for ALL students in the selected class/group of classes. If
you wish to run this for a specific student/group of students, you can:

1.

Include Dropped Students — Check the option to include dropped students in this
report.

. Click on Add/Remove Students.

. Check the box to the right of student names for whom you wish to run the report.

Uncheck the box to the right for the student names for student whom you do not
wish to run the report.

Criteria  Students  Format

Include Dropped Students

‘ B The report applies to al students in the selecled classes.

FILTER &
Jj!_ Accurso, John Dean

‘!‘.L Albane, Lauren

A Atkinson, Sean

& Azueta, Mya

At Blanc, Mikayla

< 1< TR < I < T < I <

Legend
Icons g - Date Entry *- Required Field

Format - The Format tab allows users to set some additional formatting options.

1.

2.

Orientation - Set the Orientataion of the report to either Portrait or Landscape.

Output - Set the Output type for the report. Currently the only output type for
this report is PDF.

. Page Break - Check if you would like the report to break between students. This

will allow each student’s printed report to begin on a new page.

. Exclude Row Shading - Check to Exclude Row Shading. If checked the report

will appear all white. If left unchecked it will alternate each row of data between a
white row and a gray row.

. Top Note - If you would like to include a Top Note (the same note at the top of

each student’s report) check the box to include. If you would like it to appear
bolded check the box to bold. Enter the text of the note in the text box. Please
note the Character Limit of 256 characters.
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6. Bottom Note - If you would like to include a Bottom Note (the same note at the
bottom of each student’s report) check the box to include. If you would like it to
appear bolded check the box to bold. Enter the text of the note in the text box.

Please note the Character Limit of 256 characters.

7. Signature Line - If you would like to include a signature line at the bottom of
each student’s report check the box to include. This will put a place for a
signature and date at bottom of each report.

Criteria  Students | Fomat
Orientation

Output

Page Break

Exclude Row Shading

Top Note

Characters Left: 256

Bottom Note

Characters Left: 256

Signature Line

Legend

Icons i - Date Entry *- Required Field

Once all options have been

PREPARED BY:

Landscape v
FDF  «
E4 Between Students
(Saves ink for printed reports)

Include Bold

Include Bold

Include

selected click Run Report.
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Multi-Function Assighnment Report

Start > Reports > Multi-Function Assignment Report

The Multi-Function Report provides the teacher with a list of assignments and student
scores. It is an easy way to quickly find any students with missing, late or incomplete
assignments.

Criteria

1. Report Title - By default this report is called the “"Multi-Function Assignment
Report but it can be renamed.

2. Classes - Select the class/classes for which you want the report to run. For
multiple classes click on the drop down and then check the box for the selected
classes.

3. Sort Options

e Students - Select how you want the finished report to sort.
Options include:
o Gradebook Preference
oLast Name,
o First Name
o Student Number

e Assignments - Select how you want Assignments sorted.
Options include:
oDue Date (Newest First)
o Due Date (Oldest First)
o Category and then Due Date (Newest First)
o Category and then Due Date (Latest First)
4. Data - What data would you like included in your report?
e Show Percentages - Check to include, uncheck to exclude.

e Show Assignment Comments - Check to include, uncheck to exclude.

5. Date Range - Date Range options will appear based on the options you chose
under Data > Areas to Include.

e Assignment Date Range - Select the date range for which you would like
to include assignments. You can select:
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Full Class - Includes assignments for the entire length of the class to
date.

Manual - Enter a Start and End date for the assignments you wish to
include

Individual Reporting Term - Select the specific Term for which you
want to print assignments.

6. Data Filters

PREPARED BY:

Assignment Attributes - Determine which type of categories you would
like to include. The user can select any combination of Attributes. Options
include:

(@]

O O O 0O 0O O

Missing

Late

Incomplete

Collected

Absent

Exempt

Blank Grade (excluding Exempt)

Assignment Scores - There are various options for selection the type of
scores to report. Depending on the option selected additional input will be
required

o

o

Grade Range - If selected, identify the Max and Min Letter Grade a
student can have earned on assignments.

Percent Range - If selected, identify the Max and Min Percentage
Grade a student could have earned on the assignments.

Color Level Range- If selected, identify the Max and Min Color (as
determined by the Grade Scale) student can have earned on
assignments.

Specific Grades - If selected, choose the specific grade/grades a
student can have earned on assignments

Assignment Categories - Select the category/categories for which you
would like include assignments on this report.
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Criteria Students Format
Report Title Multi-Function Assignment Report
DESCﬂptIOH List of students and scores per assignment. Useful for finding missing/late assignments, low grades, high grades, incomplete, and more.
Classes” Select Classes | w
4 Class: 1(Thu) 3{Mon-Tue, Fri) 4\\Wed) English Language Arts Grade 4
Sort Options
Students Last Name
Assignments Due Date (Mewest First) s
Data
Show Percentages

Show Assignment Comments

Date Range

Assignment Date Range T3 | w

Data Filters

Assignment Aftributes Fiter Assignments =~ Any Assignment
Assignment Scores Fiter Scores |« Any Scores
Assignment Categories Fiter Categories =~ Any Category

Students - On the Students Tab users will need to select the Student/Students for
whom the report needs to be run.

By default, the report will run for ALL students in the selected class/group of classes. If
you wish to run this for a specific student/group of students, you can:

1. Include Dropped Students — Check the option to include dropped students in this
report.

2. Click on Add/Remove Students.

3. Check the box to the right of student names for whom you wish to run the report.
Uncheck the box to the right for the student names for student whom you do not
wish to run the report.

Crieiia | Students  Fomat
Include Dropped Students

Show Selected Students Add/Remove Students

8 The report appiies to all students in the selected classes.

FILTER x
Aft Acourso, John Dean
ARt Abano, Lauren
A Atkinson, Sean
m_ Azueta, Mya
m Blanc, Mikayla -

Legend
Icons g - Date Entry *- Required Field
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Format - The Format tab allows users to set some additional formatting options.
1. Orientation - Set the Orientataion of the report to either Portrait or Landscape.

2. Output - Set the Output type for the report. Currently the only output type for
this report is PDF.

3. Page Break - Check if you would like the report to break between students. This
will allow each student’s printed report to begin on a new page.

4. Exclude Row Shading - Check to Exclude Row Shading. If checked the report
will appear all white. If left unchecked it will alternate each row of data between a
white row and a gray row.

5. Top Note - If you would like to include a Top Note (the same note at the top of
each student’s report) check the box to include. If you would like it to appear
bolded check the box to bold. Enter the text of the note in the text box. Please
note the Character Limit of 256 characters.

6. Bottom Note - If you would like to include a Bottom Note (the same note at the
bottom of each student’s report) check the box to include. If you would like it to
appear bolded check the box to bold. Enter the text of the note in the text box.
Please note the Character Limit of 256 characters.

Ciera  Students | Format

Orientation Landscape  w

Qutput PDF

Exclude Row Shading E4 (Saves ink for printed reporis)

Top Note Include Bold

Characters Left: 256

Bottom Note Include Bold

Characters Left: 256

Legend

Icons [ - Date Entry *- Required Field

Once all options have been selected click Run Report.
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Student Roster

Start > Reports > Student Roster

The Student Report is a report than can be generated either for list of students along
with available demographics data as well as blank columns.

Criteria - On the Criteria tab users will need to identify the following:

1. Report Title - By default, this report is called the “Individual Student Report” but
it can be renamed.

2. Classes - Select the class/classes for which you want the report to run. For
multiple classes click on the drop down and then check the box for the selected
classes.

3. Sort Options

e Students - Select the order in which you would like the results sorted.
Options include:
o Gradebook Preference
olLast Name,
o First Name
o Student Number

4. Display - What data would you like included in your report?

e Columns - Select what information you would like each column to contain.
Click Add to add that column to the report.

o Blank columns

o Student Data Course Name
e Birthday
e Gender
e Grade Level
e Student Number

o Parent Data*

e Mother’'s Name
Father’'s Name
Home Phone
Guardian Email
Emergency Contact 1
Emergency Contact 1 Phone
Emergency Contact 2
Emergency Contact 2 Phone
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*Parent data will only be pulled from the default Parent fields. It will not be pulled
if the data is stored in custom fields.

Criteria Students Format
Report Title Student Roster Report
Description Student demographic information and blank columns, listed one row per student.
Classes Select Classes | w
1 Class: 1(Thu) 3(Men-Tue Fri) 4(Wed) English Language Arts Grade 4
Sort Options
Students Last Name v
Display
Columns Add Columns |
Column Column Name on Report Order Remove

Student Name  Name

Students - On the Students Tab users will need to select the Student/Students for
whom the report needs to be run.

By default, the report will run for ALL students in the selected class/group of classes. If
you wish to run this for a specific student/group of students, you can:

1. Include Dropped Students — Check the option to include dropped students in this
report.

2. Click on Add/Remove Students.

3. Check the box to the right of student names for whom you wish to run the report.
Uncheck the box to the right for the student names for student whom you do not
wish to run the report.

Criteria Students Format
Include Dropped Students

Show Selected Students Add/Remove Students

B8 The report appiies to all students in the selected classes.

FILTER x
Aft Accurso, John Dean
ARt Abano, Lauren
ARt Atkinson, Sean
m_ Azueta, Mya
m Blanc, Mikayla

Legend
Icons jig - Date Entry *- Required Field
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Format - The Format tab allows users to set some additional formatting options.
1. Orientation - Set the Orientataion of the report to either Portrait or Landscape.

2. Output - Set the Output type for the report. Currently the only output types for
this report is PDF or Excel.

3. Page Break - Check if you would like the report to break between students. This
will allow each student’s printed report to begin on a new page.

4. Exclude Row Shading - Check to Exclude Row Shading. If checked the report
will appear all white. If left unchecked it will alternate each row of data between a
white row and a gray row.

5. Top Note - If you would like to include a Top Note (the same note at the top of
each student’s report) check the box to include. If you would like it to appear
bolded check the box to bold. Enter the text of the note in the text box. Please
note the Character Limit of 256 characters.

6. Bottom Note - If you would like to include a Bottom Note (the same note at the
bottom of each student’s report) check the box to include. If you would like it to
appear bolded check the box to bold. Enter the text of the note in the text box.
Please note the Character Limit of 256 characters.

Ciera  Students | Format

Orientation Landscape  w

Qutput PDF  ~

Exclude Row Shading E4 (Saves ink for printed reporis)

Top Note Include Bold

Characters Left: 256

Bottom Note Include Bold

Characters Left: 256

Legend

Icons [ - Date Entry *- Required Field

Once all options have been selected click Run Report.
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Scoresheet Report

Start > Reports > Scoresheet Report

The Scoresheet Report is a report than can be generated either for a single student or
group of students. It can be used as a Progress Report, a report to list missing/late
assignments, low grades, high grades, category totals or any combination of these
items.

Criteria - On the Criteria tab users will need to identify the following:

1.

Report Title - By default this report is called the “Individual Student Report” but
it can be renamed.

. Classes - Select the class/classes for which you want the report to run. For

multiple classes click on the drop down and then check the box for the selected
classes.

. Student Field - Select what student data you would like to include.

Options Include:

. Student Name
. Student Number

. Sort Options Students - Select the order in which you would like the results

sorted.
Options include:

o Gradebook Preference
oLast Name,

o First Name

o Student Number

. Items to Include - Select the data you want to like included in your report.

e Categories - Select the category/categories you would like to include in the
report.

e Final Grades - Select the Term(s) for which you want Final Grades to print.

e Date Range - Select the date range for which you want assignments to
print.

PREPARED BY: 77
Logic
group

PowerSchool”Hosting and Training Solutions



PoOWERTEACHER PRO USER GUIDE

Classes®

Student Field

Sort Options
Students

Items to Include

Categories

Final Grades

Date Range

Select Classes

Student Name

Gradebook Preference

Select Categories

Select Reporting Terms

Q1

1 Class: 25 2nd Grad

Students - On the Students Tab users will need to select the Student/Students for

whom the report needs to be run.

By default, the report will run for ALL students in the selected class/group of classes. If
you wish to run this for a specific student/group of students, you can:

1. Include Dropped Students — Check the option to include dropped students in this

report.

. Click on Add/Remove Students.

. Check the box to the right of student names for whom you wish to run the report.
Uncheck the box to the right for the student names for student whom you do not
wish to run the report.

Crtera  Students | Fomat
Include Dropped Students

Show Selected Siudents | Add/Remove Students

B e report appiies to al students in the selected classes

<]

FILTER x

<]

A Accurso, John Dean

Ay Abano, Lauren

(< I |

At Atkinson, Sean

A Aoueta Mya

A Bianc, Mikayia
Legend

Icons & - Date Entry *- Required Field

(< | < ]
‘
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Format - The Format tab allows users to set some additional formatting options.
1. Orientation - Set the Orientataion of the report to either Portrait or Landscape.

2. Output - Set the Output type for the report. Currently the only output type for
this report is PDF.

3. Page Break - Check if you would like the report to break between students. This
will allow each student’s printed report to begin on a new page.

4. Exclude Row Shading - Check to Exclude Row Shading. If checked the report
will appear all white. If left unchecked it will alternate each row of data between a
white row and a gray row.

5. Top Note - If you would like to include a Top Note (the same note at the top of
each student’s report) check the box to include. If you would like it to appear
bolded check the box to bold. Enter the text of the note in the text box. Please
note the Character Limit of 256 characters.

6. Bottom Note - If you would like to include a Bottom Note (the same note at the
bottom of each student’s report) check the box to include. If you would like it to
appear bolded check the box to bold. Enter the text of the note in the text box.
Please note the Character Limit of 256 characters.

7. Signature Line - If you would like to include a signature line at the bottom of
each student’s report check the box to include. This will put a place for a
signature and date at bottom of each report.

Ciiteia  Students | Format

Orientation Landscape  w

Qutput PDF |«

Page Break E4 Between Students

Exclude Row Shading (Saves ink for printed reports)

Top Note Include Bold

Characters Left: 256

Bottom Note Include Bold

Characters Left: 256

Signature Line Include

Legend

Icons g - Date Entry *- Required Field

Once all options have been selected click Run Report.
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Settings

Student Grade Scales

Start > Settings > Setup > Student Grade scales

When enabled by your district administrator, Teachers can apply a different grade scale
to specific students within each class. The grades scales available must be defined at the
district level.

When assigned, an orange triangle indicator will appear, in the upper right corner of the
box containing the student’s name, in any screen where a class roster appears.
(Assignments, ScoreSheet, Traditional, Standards, Comment Verification, Category
Totals and All Reporting Terms.)

When scoring an assignment, the score inspector will display a message indicating that
the student has a custom grade scale assigned.

1. On the menu bar, select Settings, A R

Grading

and then choose Student Grade Scales.

m Student Grade Scales

Students

Progress
.
=4
Reports Traditional Grade Calculations

o

Settings

Class Descriptions
Display Settings
Student Grade Scales ExpandAll | Collapse All
» 1(A) Homeroom
» 2(A) 2nd Grade English
Standards Grade Calculations

» 3(A) 2nd Grade Math

» 4(A) 2nd Grade Social Studies

» 5(A) 2nd Grade Science

Legend
Icons da Grade Scake Locked by District

2. Click the arrow next to the class name to expand the class view. Any Student
Grade Scales already assigned for the class will appear. If no grade scales exist, a
message appears.

No Grade Scales assigned:

v 3(A) 2nd Grade Math

Add

a No student grade scales found.
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Student Grade Scales Assigned

v 3(A) 2nd Grade Math

m Booth, Chris 4-1 Traditional

m Coffey, Raul 4-1 Traditional

STUDENT GRADE SCALE REMOVE

Add

:
:

3. To apply a specific grade scale to a student or students, Click Add.

v 3(A) 2nd Grade Math

Add

[ B Mo student grade scales found.

4. On the Choose Students and Grade Scales
window, select the appropriate grade scale
from the menu.

5. Use the Filter field to reduce the list of
students. For example, type "A" to reduce
the list to only students with the last name
that begins with "A".

6. Select the checkbox next to each student
for who you wish to assign the selected
grade scale. Click the checkbox at the top
of the column to select all.

7. Select Save.

3(A) 2nd Grade Math - Choose Students and Grade Sca... | |

Choose Grade Scale __.‘ 4-1 Traditional

Choose Students ‘Washington Elementary Rubric

FILTER
100 Point Scale

A Booth, Chris | 4-1 Traditional
. ‘Washington Elementary Traditional
m Brown, Jessica

e Coffey, Raul

A Gahner, Matt

s Aol Do

R M

3(A) 2nd Grade Math - Choose Students and Grade Sca...

Choose Grade Scale 4-1 Traditional
Choose Students

FILTER X
M Booth, Chris S~

A Brown, Jessica
M Coffey, Raul \

M Gahner, Matt

alls Aol Dead M
Cancel
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8. If a new grade scale is applied mid-term, _ﬂ

the following message will appear. B3 e stucent grade scale will be updated. Al
new traditional grade and score entries will
Note that the new grade scale will ONLY apply use this updated scale. Previously entered
. grades and scores will not be automatlcally
to assignments created after the new grade recalculated.
scale has been applied. It cannot be applied to
assignments/scores already entered. : -
Discard Changes S.':WECI'BHQ(-S

Click Save Changes to proceed.

Test Chapter 6 n

Once the new grade scale has been assigned

to a student, you will see an orange i I —
triangle in the upper right corner of the - - '
student’s name cell. e
SCORE
STUDENTS (19) (10T A 20A02
1 1. Booth, Chris

AL 2. Brown, Jessica

O

m 3. Coffey, Raul

m 4. Gahner, Matt

When entering assignment scores, the Score Inspector will indicate if a student is
using a Student Grade Scale. The available entry options will display based on the
grade scale assigned to the student.

Score Inspector - Student Grade Scale Score Inspector - Class Grade Scale

Booth, Chris Brown, Jessica

Score Score
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Display Setup

Start > Settings > Setup > Display Setup

Use the Display Settings page to configure the layout of items in the Gradebook.

Display Settings

Class Names

Display and Sorting

Standards Grades 9

Show Standards Pages and Links
Show Standards on Assignments
Auto-Calculate Assignment Standards Scores Initial State

Navigation Links Sort Order

Professional Judgment Helper

Traditional Grades e

Show Traditional Grade on PowerTeacher Pro Screens

Values to Show in the Traditional Grade Column

Student Names 0

Display

Sort Students by

1. Class Names

Period / Day v

Unchecked

Traditional, Standards v

Show on Grading : Standards

Show on Students - Standards Progress

Select Values |

Grade, Percent

Last, First v

Example: Smith, John

Last Name -
Add newly enrolled students to the bottom

Hide pre-registered students

Om

e Display and Sort - This will determine the Order the Classes are displayed in
PowerTeacher Pro. If using Custom Display Names for sections. Teachers will
enable the option by selecting the appropriate option from the drop down.

Class Names

Display and Sorting

Traditional Grades

Values to Show in the Traditional

Grade Column

Custom Name (sort by Period / Day) ‘

Period / Day

Section Number (sort by Number)

Section Number (sort by Course Name)

Show Traditional Grades

Custom Name (sort by Custom Name)

| Custom Name (sort by Period / Day)

. Period/Day will display the Period/Day combination for each class and
then sort classes first by the Period they are scheduled and then the

day.
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Ex: P1(A)
P2(A)
P1(B)

. Section Number (sort by Number) will display the Section humber of
each class and then sort numerically/alphabetically by the section
number.

. Section Number (sort by course name) will display the section number
then sort alphabetically by the course name.

. Custom Name (sort by course name) will display the Period/Day

combination for each class as well as the Custom Display name. It will
then sort alphabetically by the Custom Display name.

o Custom Name (sort by Period/Day) will display the Period/Day
combination for each class as well as the Custom Display name. It will
then sort first by the Period they are scheduled and then the day.

Professional Judgement Indicator - If using standards grades, the
Professional Judgment Helper is designed to help you in assessing standards
grades. When enabled, the last three standards grades are evaluated to
determine if the student scored higher than the standards final, calculated
Standards grade. The indicator helps you quickly see which grades to
focus on to determine if the final grade accurately reflects the student’s level of
understanding.

Using your professional judgment, you can decide if any changes need to be
made to the final grade.

Professional Judgment Indicator f4 Show on Grading : Standards

f%4 Show on Students : Standards Progress

3. Traditional Grades

PREPARED BY:

Show Traditional Grades on PowerTeacher Pro Screens - Check to show
Traditional Grades, Un-check to hide them. Unchecking this option will
remove the Traditional Final Grade Column from affected screens.

Values to Show in the Traditional Grade Column - Select the options for

the way you want Final, Traditional Grades to appear in the Grade Column.
Options include:

Select Values | A

. Grade - Letter Grade from Grade Scale
. Percent - Calculated Percent Score Grade
. Points - Points earned/Points Possible Persent

| v |
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4. Student Names

e Display - Determine the way you would like student names to display in PTP.
Options include: Lost, P R
) Last, First

Last, First

. Last, First M.

° Last, First Middle Last, Frt M.
. First Last Last Frst i
. First M. Last i

[ ]

First Middle Last

First M. Last

First Middle Last

e Sort Students By - Determine the order in which you would like Student
Names to appear the Assignment and Score Sheet view. Options include:

e Last Name

e First Name

e Grade Level, then Last Name First Name

e Grade Level. then First Name

Last Name

Grade Level, then Last Name

Grade Level, then First Name

e Additional Sort Options include the ability to add newly enrolled students to
the bottom of the list (check the box to enable) and to Hide Pre-Registered
students (check to hide).

5. Save - Click Save to save any changes made to the Display Setup.

Class Description

Start > Settings > Setup > Class Description

The Class Description screen displays basic information about each course including
such items as Course Name/Number, Section Number, and Period the class meets,
Start and End Date, Term of class and Grade Scale. It is on this screen that
teachers can add a Custom Class Name to be used to more easily identify one section
from another. Additionally, there is a Description box which the user can enter
information that will be visible on the Scores Detail Screen of the Quick Look and/or
Parent Portal Grades and Attendance screen. The Class Description does offer additional
formatting options including the option to create a “Link” to data stored in a different
location. Note that each class is included on this screen and is accessible by clicking on
the arrow to the left of the course. Descriptions entered are specific to the course for
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which they are entered. If a teacher wishes to have a description for each class, he/she
must enter the information into the Description box for each class.

Class Descriptions Expand Al Collapse Al
Course Name: Homeroom Term: 16-17
Course Number: HR Start: 8/1/2016 - Monday
Section Number:; 25 End: 7/29/2017 - Saturday
Period / Days: 1(a) Grade Scale: A Numeric Example Scale

Custom Class Name:/Social Studies 3
Class Description:

B I U| A- | Size -

mw
1]
i
H
B
3]
5L

Traditional Grade Calculation

Start > Settings > Setup > Traditional Grade Calculation

This screen allows the user to enter/view/edit the Traditional Grade Calculation for
each class. New with Powerteacher Pro is the ability to push out Traditional Grade Setup
from the District/School level. If done, teachers will not have to go in and manually
configure the Grade Setup. If the Traditional Grade Setup is done at the District Level,
they can determine if teachers will be given the option to modify the grade setup or not.
If setup is not done by the district teachers will need to setup the specific weighting for
EACH term in EACH class. This can be done term by term, section by section or
teachers can use the Copy Grade Setup option.

Traditional Grade Calculations O & seaoa | colapsen
» 1(A) Social Studies 3 0
v 2(A) 2nd Grade English (2
5 6 7
REPORTING TERM FORMULA TYPE 6 EDIT CALC EDIT DROPS ACTIONS

e S1 Term Weighting \/ \/ /
(o}] Category Weighting / / /
Qz Category Weighting / \/ /
52 Term Weighting \/ \/ /
Q3 Category Weighting \/ ‘/ /
Q4 Category Weighting \/ \/ /

1. Use the Expand All/Collapse All buttons to open/close the calculations
windows for each class.

2. Use the arrow to the left of the course name to open the window to allow for
calculation setup.
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W

8

. Reporting Term lists the Reporting Terms as seen in the Teacher’s Gradebook.
. Formula Type - Shows the defined calculation method. If no method is
defined it will default to Total Points.

. Edit Scale, if checked, lets the teacher know that he/she can create/modify a
calcultion for the selected term.

Edit Drops, if checked, lets the teacher know that he/she can set whether they
want to drop the lowerst score for a student.

Click on the Actions icon to setup/modify the exiting Grade Calculation Method
for the selected term.

. Copy Traditional Grade Calculation - Use this function to copy grade setup
from one term to another and/or one section to another.

Actions - Formula

The types of available calculation methods will vary depending on the Reporting Term
selected. All terms have the basic options of Total Points, Standard Weighting and
Category Weighting but Terms that encompass shorter Terms also include the option for

Term Weighting.

T1 “eporting Term for HR1(Mon-Fri) Homeroom Grade 4

SCONEs

1. Select Formula if defining the Formula. Select Drop Low Scores if
configuring which scores, if any, to drop.

2. Calculate Overall Class Grade - Check to enable, uncheck to disable. This

will allow you to see an overall class average for based on the final grade for
all students.

3. Click Add to add additional rows to the Calculation method. This is most
commonly used with Term and Category Weighting.

4. Select the Type of Weighting to be used. Options include:
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Total Points - All asssignments set to be included in the final grade will
be inclulded. The final grade will be determined by adding up the total
number of earned points and dividing it by the total number of possible
points. If assignment weighting is applied to any assignment, that
weighting will be applied prior to the final calculation. This calculation
met does not take into account standards and/or the categories to which
assignmentes are assoicated.

For this method there will be only one row within the method, the weight
will be set to 1 and the percent to 100%

Category Weighting - The Final grade for a course can be calculated
based on the average from pre-defined categories. As a teacher adds
assignments to each category the final grade will adjust based on the
score of the assignment and the category to which it is associated. (Ex:
Test = 50%, Quizzes = 25%, Classwork = 15%, Homework =10%). In
all cases, the total of all categories must equal 100%.

For this method there will be onr row per category. The weight for each
category must be defined with the total weight of all categories equalling
100%.

Term Weighting - This option is only availble if there are lower
(shorter) Terms tied to this class. Ex. Y1 is calculated from S1/S2, S1 is
calculated from Q1/Q2, etc.

For this method there will be one row per Reporting Term being included
in the calculation. The weight needs to be set to the value of each term.
Ex: If Y1 is made up of Q1, Q2, Q3 and Q4 then set the Weight for each
term to 25%.

Additionally Term Weighting offers the teacher the additional option of

defining whether they want the final grade calculated based on the Exact
Value Earned (this is the Percent score) or the Term Weighting Points
(this would show the final grade based on the corresponding GPA Points).

Term Weighting Exact \alue Eamed A

5. Weight - Define the weight of the specified category or term. (Ex: Test =
50%, Quiz = 25%, etc.)

6. Percent - This field will auto calculate based on the value entered in the
weight column.
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7. Click on the - to delete the row from the calculation method.

Actions — Drop Low Scores

When using either any calculation method, other than Term Weights, Teachers have the

option to Drop Low Scores for any given class. There are several options the teacher
can choose from when using this function.

T1 Reporting Term for 1(Thu) 3(Mon-Tue,Fri) 4(Wed) Eng... T1 Reporting Tem for 1(Thu) 3(Mon-Tue,Fri) 4(Wed) Eng...

Formula | Drop Low Seores

Formula Drop Low Scores
Low Scores

Low Scores

Drop Low Scores

Low Scores - Teachers can define the way in which PowerTeacher Pro drops scores.

e Lowest Grade or Percent will drop the lowest score regardless of the
assignments weight

Student Advantage will drop the score regardless of weight or category
that will give the student the best advantage.

Drop Low Scores — There are three options from which the teacher can choose.
e None - No scores are dropped. [ T1 Reporting Term for 4 (Thu) 3(Mon-Tue,Fri) 4Wed) Eng__.__|

Drop Low Scores

Low Scores

Drop Low Scores

T1 Reporting Term for 1(Thu) 3(Mon-Tue, Fri) 4(Wed) Eng__ E

Drop Low Scores

e Drop Lowest Overall - If selected

The teacher must define the number
of scores to drop.

Number of Scores to Drop

Low Scores
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e Drop Lowest by Category -
If selected the teacher must
select not only which categories
(there can be more than one) but
also how many scores to drop.

T1 Reporting Term for 1(Thu) 3(Mon-Tue,Fri) 4(Wed) Eng...

nula | Drop Low Scores

Low Scores

Drop Low Scores

Copy Traditional Grade Setup

Once Grade Setup has been completed for one term or one class you can use the Copy
Traditional Grade Setup Function to copy the setup into additional terms/sections.

Copying Term to Term.

1. Click on the Gear icon in the upper right corner of the screen. ﬁ
2. Click on the Copy Traditional Grade Calculation link to open the

copy function.

Copy Traditional Grade Calculations |:>

moowp

term.

Select Within A Class.

Select the Class from which you are copying grade setup.
Select the Term setup you wish to copy.

. Selct the Terms to which you want to copy the orignal setup.
Check if you wish to recalculate Final Grades for the selected

Copy Traditional Grade Calculations x
Copy Terms 0 Within AClass @ To Another Class
From
Class e 1 Sociclogy
Reporting Term e Q1 (Category Weighting)
To
Reporting Term @ Select Reporting Terms
Q3 (Category Weighting], 52 (Term Weighfing)
Q4 [Category Weighting) : :
Recalculate Final Grades 03 (Category Weighting) e
Q4 (Category Weighting)

Click Validate. The Validation scren will appear. If all is good
then click Copy to complete the copy Process.
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Copy Traditional Grade Calculations X

Summary
FROM: 4(A) SOCIOLOGY
TO: 4{A) SOCIOLOGY
RECALCULATE FINAL GRADES: YES
COPY COPY
FROM TO CALC DROPS INFO

a1 Q3 v v

Qi Q4 v v
Previous

A Validation Bar will appear at the top of the screen indicating that the
Copy has been successful.

é .'/ Grade Calculation for 2(A) 2nd Grade English Reporting Term S2 (Term Weighting) copied from Reporting Term S1 (Term
Weighting).
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Copying Class to Class

&

3. Click on the Gear icon in the upper right corner of the screen.
4. Click on the Copy Traditional Grade Calculation link to open the

copy function.

Copy Terms Within A Class @ To Another Class @
From
Term @ Semester 2 (16-17)
Class e 1 Sociology

To
Copy Traditional Grade Calculations |:> Term @ — T

Class Select Classes
2 AF Calculus

2 AP Calculus /]
Recalculate Final Gradee

2 Pre-Calculus
6 Geometry
9 Geometry

Validate

Select To Another Class.

. Select the Term from which you want to copy.

Select the Class from which you want to copy.

Select the Term to which you wish to copy.

Selct the Classes to which you want to copy.

Check if you wish to recalculate Final Grades for the selected
term/class.

RE-ITIom

Click Validate. The Validation scren will appear. If all is good
then click Copy to complete the copy Process.

Copy Traditional Grade Calculations n

Summary

FROM: 2(A) 2ND GRADE ENGLISH (2016-2017)
TO: 3(A) 2ND GRADE MATH (2016-2017)
RECALCULATE FINAL GRADES: YES

COPY  COPY

CALC DROPS N~

FROM TO

Category mismatch. Lead teacher must be the
same in the source and destination classes and
Q1 Q1 all categories used in category weighting in the
source class must be available to the
destination class
Category mismatch. Lead teacher must be the
same in the source and destination classes and
Q2 Q2 all categories used in category weighting in the
source class must be available to the
destination class

S1 $1 v v
Category mismatch. Lead teacher must be the <

Previous

A Validation Bar will appear at the top of the screen indicating that the
Copy has been successful.

2 \/ Grade Calculation for 2(A) 2nd Grade English Reporting Term S2 (Term Weighting) copied from Reporting Term S1 (Term b 4
Weighting)
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Apps
PowerTeacher Portal

Start > Apps > PowerTeacher Portal

Use the PowerTeacher Portal link to return to the PowerTeacher Start Page.

A" PowerTeacher Portal |:7|lI
Grading

 J

Students

Progress

Entering Grades and Comments

PowerTeacher Pro allows for student scores and comments to be entered in a variety of
locations. Most commonly, teachers will use the Assignment view and Scoresheet View
in the Grading Section to enter grades while Final Comments can be entered through
where the Final Grade appears.

The Assignment view will allow the teacher to view one assignment at a time. The more
common Scoresheet view allows teachers to view multiple assignments at one time.

The ability to manually overwrite Traditional Finals grades also exists and is not limited
to just the Scoresheet. Traditional Final Grades can be manually overwritten on all
Screens in the Grading Section except the Category screen, as well as the Students
Screens in the Comment Log.

Traditional — Assignment Scores

Traditional Assignment Score entry, as mentioned above, can be completed from either
the Grading > Assignment screen, the Grading > Score Sheet or the Student >
Assignment screen.

e Class Assignment - Teachers can enter scores for a single assignment for
multiple students. If the same assignment has been linked to multiple classes that
teacher can enter grades for ALL students at one time rather than having to switch
from one class to another.
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To Enter Scores:

1. Select the class or group of classes from the top of the screen.

2. Go to Grading > Assignments

3. Select the Assignment for which you want to enter grades.

4. Enter the scores either by typing the grade directly into the
grade cell or by using the Score inspector (see section on Score
Inspector below). The first column is always the Traditional
Assignment score, if Standards are associated a column for each
standard will appear to the right. (See section below on how to
enter Standards Grades.)

B Test Chapter 1 ~

> Filter

58 of 58 items

Assignment: Test Chapter 1 Sat dasgnment Show More ‘

[ Clear I Apply l

Score: 4 | 90% | 90/100 Due: 4/19/2016

Score Type: Percent

SCORE
(4119/2016)

STUDENTS (58) A GAELA1 G4ELA3

4 1. Accurso, John Dean

1(Thu) 3(Mon-Tue, Fri) 4( €0 4 2
4’; 2. Albano, Lauren
1(Thu) 3(Mon-Tue,Fri) 4( 4 2
[!]
=
A 3. Atkinson, Sean
80 4 2

1(Thu) 3(Mon-Tue, Fri) 4(

i 4 Azueta. Mva

e ScoreSheet — Teachers can enter scores for multiple assignments, for multiple
students. The students that appear on the score sheet will depend on the
class/group of students that have been selected. If multiple classes have been
selected the list of students will include students from all classes. Note that
Standard scores cannot be entered in the Scoresheet View.

To Enter Scores:

PREPARED BY:

Select the class or group of classes from the top of the screen.
Go to Grading > Scoresheet

Put the cursor in the first, blank grade cell of the assignment
for which you want to enter scores.

4. Enter the scores either by typing the grade directly into the
grade cell or by using the Score inspector (see section on
Score Inspector below).

WN -
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HSE‘ PowerSchool

2(A) 2nd Grade English

» 5 Classes - s2 (15-16)

Class Grade: Q4 Calculation: Standards Weighting

Grade Scale Type: (A -F)

Grade: B | 86% | 1294 150

STUDENTS (19) COURSE GRADE ~ Test Chapt..  Test Chapt
(7172018) (T7a2016)

Homonyms ~ Pages 5-10...  Using the

(713012016)

(71302016)

(71302018)

gt 1. Booth, Chris B 86%,
1291150

gt 2. Brown, Jessica B 86%.
129/150
At 3. Coffey, Raul o 63%.
95/150
st 4 Gahner, Matt B 86%
129/150
fr 5. Gall, Brady B 86%
129/150
St 6. Goodrich, Joshua B 86%.
129/150
At 7. Henderson, Aaron B 86%
120/150

20

22

20

25

20

e Student > Assignment - Teachers can use this screen to enter scores for
multiple assignments for a single student. By selecting All classes before
navigating to this screen the teacher will be able to see all assignments for a
student at one time. Note that Standards grades cannot be entered through this
screen. You can view the number of entered grades but they cannot be entered or
modified.

To Enter Scores:

PREPARED BY:

B

1. Select the class or group of classes from the top of the screen.

2. Select the Assignment for which you want to enter grades.

3. Enter the scores into the Score column either by typing the
grade directly into the grade cell or by using the Score
inspector (see section on Score Inspector below).

PowerSchool
i Booth, Chris - Assignments

5 of 5 items

» 2(R) 2nd Grade English - 15-16

Qcrexte @ L uscahal

Assignment: Using the Dictionary

Score Type: Points (25) Score: — | — | 125

ASSIGNMENT SCORE DUEDATE v STANDARDS
ﬂw. Using the Dictionary I:I 71302016 o gl
Ez. Pages 510 Quiz 10 773012018 1ol
=3. Homony 20 71302016 2l
=4. Test Chapter 2 7182016, 2 ol
=5. Test Chapter 1 71712016, 0 ol

95

PowerSchool”Hosting and Training Solutions



PoOWERTEACHER PRO USER GUIDE

Exporting / Importing Scores

There are times when you may need to score assignments outside of PowerSchool or
Import scores from another application. The Export / Import function within
PowerTeacher Pro will allow you to do this. In order for this function to work the
assignment must first be setup in PowerTeacher Pro.

If exporting scorers from another program you would want to make sure that the import
template is setup using the same format as a file exported from Power Teacher Pro. The
most common import file types are .csv and .txt. (Exports from PowerTeacher Pro will
be in .csv format.)

H@ PowerSchool

To Import scores for an existing PTP Assignment:
1. Go to Grading >Assignment List.

2. Click the name of the assignment you wish to export.

Assignments
A Q1 is already completed
ATEGORY ASSIGNMENTS SCORED DUE DATE ¥ SCORE TYPE EDIT
*@‘ 1. Chapter 6 Test 0/15 10/17/2016 ::r?f”‘ y4
Grade Scale

2. Chapter 7 Test 15/15 10/17/2016 pls: 100 ./

3. In the upper-right corner of the assignment page, click the Gear icon.

o

4. Select Export Scores Template. If there are any existing |  Hide Summary
assignment scores, choose whether or not to include the scores
in the exported file by clicking Yes or No in the Export Scores

Template window. Show Standards

Show Metrics

Export Scores Template

Export Scores Template

‘ E Include Scores? | Import Scores

PREPARED BY: 96
Logic
group

PowerSchool”Hosting and Training Solutions



PoOWERTEACHER PRO USER GUIDE

5. Open the exported file.

The top of the spreadsheet includes the teacher's name,
class, assignment name, due date, points possible,

A
Teacher Name:
Class:

Due Date:
Points Possible:
Extra Points:

B T D

Lisa Cahall
2nd Grade English
Assignment Name: Chapter 6 Test

10/17/2016
100
0

extra points, and score type. Below the assignment
details are three columns — Student Number,
Student Name, and Score.

6. Enter the students' scores in the Score column
and save the spreadsheet as a .csv file.

- R PR SRR U

10
1

13
14
15
16
17
18
19
20
21
22

Score Type:
Student Num

PERCENT

Student Name
9029 Andersen, Apaulo
8988 Andersen, Ashley
9009 Becker, Jennifer
8995 Bertram, Stacy
8674 Bjorklund, Laura
8993 Blankenship, Jessica
9003 Booth, Chris
9012 Brown, lessica
8996 Caid, Jessica
9016 Dennis, Joshua
8670 Derbidge, Anthony
8994 Dewey, Adam
9031 Dossert, Christina
9044 Finley, Sandy

Score

L1

Teacher Name: Lisa Cahall

Class: 2nd Grade English

Assignment Name: Chapter 6 Test

Due Date: 10/17/2016

Points Possible: 100

Extra Points: o

Score Type: PERCENT

Student Num Student Name Score
5029 Andersen, Apaulo 100
8988 Andersen, Ashley 100
9009 Becker, Jennifer 85
8995 Bertram, Stacy 95
8674 Bjorklund, Laura 87
8993 Blankenship, Jessica 92
9003 Booth, Chris a3
9012 Brown, Jessica 100
8996 Caid, Jessica 85
9016 Dennis, Joshua 75

7. In PowerTeacher Pro, Go to Grading > Assignment List > Select the Assignment to
which you wish to import scores and click the Gear icon. (Steps 1-3 above)

8. Select Import Scores. %]
Hide Summary

Show Metrics

Show Standards
Export Scores T?
Import Scores
9. In the Import Scores window, click Browse Files.

10. Select the spreadsheet file you wish to import.

11. In the Format menu, use the default selection
of PowerTeacher Score Template.

97

PREPARED BY:

Import Scores into Chapter 6 Test n

File

Format

Validate Student Names

Chapter6Test_pst.csv

‘ PowerTeacher Score Te... B

I PowerTeacher Score Template

Browse Files (602 bytes)

CSV (comma separated values)
Text (tab delimited)
Other

[T Losic
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12. Check Validate Student Names to verify that the student names in the import file

match the names of the students enrolled in the class.

13. Click Next Review and correct any import errors.

14. To import and save the scores in PowerTeacher

Pro, click Import

Entering Comments

Import Scores into Chapter 6 Test

v 10 of 15 scores will be imported

Due Date
Points Possible:
Extra Points:
Score Type:
Student Num
9029

8988

9009

Previous

10/17/2016

100

0

PERCENT
Student Name
Andersen, Apaulo
Andersen, Ashley

Becker, Jennifer

A=

100

00

100

00

85

@

5

Whether entering comments for an Assignment or a Final Grade, you will use the Score

Inspector to complete this task.

Finial Grade Comments

From any page that displays the Final Course Grade,
click into the Final Grade cell for the selected student.
This will open the Score Inspector.

Allen, Victor

Course Grade - Grade

Comment
Quick Entry

Approximately 2048 Characiers Left

PREPARED BY:

STUDENTS (17)

80 1. Allen, Victor
m 2. Black, Javier

jil 3. Clark, Gracie

& 4. Darrow, Kaylee

COURSE GRADE

\ 93.51%

607.8/650

F+ 65.94%
313.2/475

B- 81.565%
448 55/550

A 93.29%

606.4/650

Comment Window - Click the Dialogue Bubble to
open the main Comment Window. Use this area to
enter comments manually or through the
School/District generated Comment Bank.

Comment Quick Entry - use this box to manually
enter a narrative comment for any student

98

PowerSchool”Hosting and Training Solutions



PoOWERTEACHER PRO USER GUIDE

Comment Window Entry

A/B - Use the up/down arrows to move
forward or back from one student to
another.

C/D - Use the left/right arrows to move from
one column to another. Useful when SOIiELE
adding Assignment Comments.

E - Main entry area for comments.

2y A Andersen, Apaulo

< C Score

Comment Bank

Approximately 4000 Characters Left

Comment Bank

F — Use the Filter to search for a

Approximately 4000 Characters Left

e F I ) ) specific comment/group of
S comments.
SJEL" Cone cowvenr G - Click the star to mark a
S comment as a favorite.
Accepts responsibility for own actions. Behavior H - CIle the + Sign tO add a
e comment to the comment
affecting grade enavier W| ndOW .

Participates enthusiastically. Effort

I - Set the default for spacing to
Line Break or Spaces.

Tries hard but continues to have
difficulty. Effort

Separate Using Line Breaks . Spaces O

When in Comment Bank mode teachers can use a combination of Comment Bank and
manual Comment entry.

Comment Quick Entry —

Use this box, at the bottom of the score inspector, to manually enter a narrative
comment for any student.

Comment
Quick Entry

Approximately 2048 Characiers Lef
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Score Inspector

Any time you click on a grade cell, whether it be an Assignment Grade, Standard Grade
or Final Grade, PTP will automatically open the Score Inspector on the right side of the
screen. The numeric values displayed in the keypad portion will appear based on the
type of grade scale, the grade options available within that scale and the assignment
setup.

The Score Inspector also offers two options for entering comments. The quick entry
block at the bottom of the Score Inspector can be used to enter a Teacher created
narrative comment or through the Comment Link in the upper right corner. This link
provides access to both a manual entry screen as well as any School/District created
Comment banks.

Bm 10/16/12 & o [ i =

Absigrant s ] -
l Scorm Type: (A F) Seare: A- PO | 183022 Due: T2T2NT A ARMSTROMNG, Stephens v

SCORE

T i = e
1. ARMSTRONG, Stephens —— 2 N 2 - ED
1. BARKER, Barbars e 3+ 3+ 3 o
3, BERG, Frank o 1 1
4. BOOTH, Elna [+ 2 2 2 2 2
5. CHAMBER S, Hemnandez >
5. COMEN, Scheidi B e 2 F
7. COSTA, Hadine 1
5. DAVILA, Laura A 3o 3
9. DOYLE, Gorden e T e T
0. ENGLISH, Black - 2 3 2 3
1. HOLT, Paimar A " " 4 4 4
12, HUMPHREY, Washington Ee 3 3 3 ] 1
13, LEVINE, Mertin o 1 ' 1 ' 5
14, LEW1S, Daniels B 2+ =+ =
15, MANNING, Clara B B 3 3 3 s
16. MCCARTHY, Harris A 4 4 4 4 4
7. MERRITT, Alvarez m B 2 b 2 2
18. OOOHNELL, Reeny m 2+ 2% 2+ 2%
19, DWEN, Reed o 1 ' 1
20, POWELL, Zican Ze T T I T
21, PRESTON, Jones B 3 3 3 3
2. ROSALES, Jackicn 5 2 2+ 2+ 2%
33, THOMAS, iacDonaid 5 : = P 2 =
4. TOWN SEND, Phoenix & & 4 F 4 -
2. TRUJILLO, Butler E 3 3

0w

Columns/Page |7

The way in which the Score Inspector key pad appears, is determined by the type of
grades being entered, the grade scale associated to the Course/Standard and the setup
Assignment setup (Score Type, Possible Points)

Traditional Grades - Assignments

The Key Pad will appear based on:

e The Grade Scale associated to the selected Class.
e The Score Type/Possible Points as defined in the Assignment Setup
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Score Inspector Layout

Individual Assignment

1.
2.

3.
. Key Pad Entry - Enter the score directly in the key pad

Click the X to close the Score Inspector.

Move up/down Student List - Use the arrows to move
up or down the list of students.

Move Across - Use the arrows to move across the row.

entry box. Whatever is entered will be used to fill in the
selected Grade field.

. Key Pad - Use the keys on the key pad to manually

Enter a score in a grade cell.

. Codes - Click to open a window that allows for the

selection of "Special Codes”. These are codes that
have been created at the District level that can be
used in addition to the regular grade scale items. If
the code has been associated with one of the
Assignment Indicators (see below) then the symbol,
for that indicator, will appear along with the code.

For example:

Special Codes

l = Select a special code.

INC | ABS | MIS | MED

. Fill Scores down - Once you have entered a

score in a grade cell, click to fill all blank cells below
the manually entered grade.

. Fill Score across - Once you have entered a score in a

grade cell, click to fill all blank cells to the right of the
manually entered grade.

. Assignment Indicators - These are additional flags That can be used with

assignment scores. Missing, Late, Incomplete and Absent can be assigned
along with an actual assignment score. Collected and Exempt would be used in
place of an actual score. Note: these codes are visible in the public portals
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10. Comment Window - Click to open the Comment Window. Use this area to enter
comments manually or through a School, generated Comment Bank.

A/B - Use the up/down arrows to move
forward or back from one student to
another.

C/D - Use the left/right arrows to move from
one column to another. Useful when SOIiELE
adding Assignment Comments.

E - Main entry area for comments.

2y A Andersen, Apaulo

< C Score

Comment Bank

Approximately 4000 Characters Left

|

20 G"‘D items
CODE COMMENT

Needs to be prepared with assigned
materials

Comment Bank

Approximately 4000 Characters Left

Accepts responsibility for own actions. Behavior

Demonstrates leadership qualities Behavior

Frequent absences from class are

eting o Behavior F — Use the Filter to search for a
Patpates entusistialy et specific comment/group of
Scury o cominues o have comments.
T Lneoreaks @) Spaces @) G - Click the star to mark a
comment as a favorite.

H - Click the + sign to add a
comment to the comment
window.

I - Set the default for spacing to

Line Break or Spaces.

When in Comment Bank mode teachers can use a combination of Comment Bank and
manual Comment entry.

11. Comment Quick Entry - use this box to manually enter a narrative comment for
any student.
Once comments have been entered a comment bubble will appear .00 o) 11-
in the score cell indicating that a comment has been entered. 108 1. Anieree Ao j’
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Citizenship Scores

If enabled from District Office, Teachers can enter Citizenship
grades for by going to Grading > Traditional. When the
Teacher clicks into the grade cell for Citizenship, the
appropriate Score Inspector will appear. Only those grades
defined for Citizenship Will be available for entry. Note that
comments cannot be entered with Citizenship grades.

Grades: Traditional - Q1

25 Homeroom

Class Grade: Q1
Grade Scale Type: Citizenship Grade:

ATTENDANCE ASSIGNMENTS
STUDENT (15) al ERESIETE () ABsENCES ) TARDIES D missinG 9 e @ INCOMPLETE
=

ARL 1 Andersen, Apaulo 4 1 1 - - -

100%
-!’!- 2. Andersen, Ashley 4 1 1

7%
& 3. Becker, Jennifer 4 1

053

Overwriting - Final Traditional or Standard Scores

When attempting to manually overwrite a Final Grade, /N fAndersen, Ashley

be it a Traditional Grade and/or Standard Grade, the
Score Inspector will look slightly different. The grade entry k<
area will contain some additional features. r

31 @ © x

1. Letter Grade - Use to manually overwrite the 98 9 e V4
final Letter Grade for a section.

2. Percentage Grade - Use to manually overwrite the
final Percentage grade for a section. Note that
updating the Letter grade will not automatically
update the corresponding percentage grade.

3. Clear Letter Grade- Use to clear any values
entered in the Letter Grade field.

4. Edit Percentage - Click the pencil icon to change
to a 10-point key pad.

5. Revert - Use to revert (undo) a manually overwritten score back to the
calculated score.

Course Grade - Grade

Caleulated - 4 - 08%
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